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¸½Ä¾À¼°Æ¸Ï ¾ ÁµÀÂ¸Ä¸º°Æ¸¸ ¿À¾´ÃºÆ¸¸
ÀÐÔØÞáâÐÝæØï ÝÞáØÜÐï (ÜÞÑØÛìÝëÙ âÕÛÕäÞÝ ßàÕÔÝÐ×ÝÐçÕÝÝëÙ ÔÛï àÐÑÞâë Ò áâÐÝÔÐàâÕ GSM 900/1800) 
Nokia âØßÐ 9210i

ð ¾Á/1-C¿Á-614

ÁàÞÚ áÛãÖÑë: 3 ÓÞÔÐ

ÁàÞÚ áÛãÖÑë, ãáâÐÝÞÒÛÕÝÝëÙ ßàÞØ×ÒÞÔØâÕÛÕÜ Ò ßÞàïÔÚÕ ß.2 áâ.5 ÄÕÔÕàÐÛìÝÞÓÞ ·ÐÚÞÝÐ ÀÄ "¾ ×ÐéØâÕ ßàÐÒ 
ßÞâàÕÑØâÕÛÕÙ", àÐÒÕÝ 3 ÓÞÔÐÜ á ÔÐâë ßàÞØ×ÒÞÔáâÒÐ ßàØ ãáÛÞÒØØ, çâÞ Ø×ÔÕÛØÕ ØáßÞÛì×ãÕâáï Ò áâàÞÓÞÜ áÞÞâÒÕâáâÒØØ 
á ÝÐáâÞïéÕÙ ØÝáâàãÚæØÕÙ ßÞ íÚáßÛãÐâÐæØØ Ø ßàØÜÕÝØÜëÜØ âÕåÝØçÕáÚØÜØ áâÐÝÔÐàâÐÜØ.

¸×ÓÞâÞÒØâÕÛì:
Nokia Corporation, Nokia Mobile Phones

°ÔàÕá:
Heikkilantie 3, FIN-00210
Helsinki, Finland

ÅÕØÚÚØÛÐÝâØÕ 3, Ä¸½-00210
ÅÕÛìáØÝÚØ, ÄØÝÛïÝÔØï
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© Nokia, 2000-2002 Ó. ²áÕ ßàÐÒÐ ×ÐéØéÕÝë.
²ÞáßàÞØ×ÒÕÔÕÝØÕ, ßÕàÕÔÐçÐ, àÐáßàÞáâàÐÝÕÝØÕ ØÛØ åàÐÝÕÝØÕ Ò ÛîÑÞÙ äÞàÜÕ ÔÐÝÝÞÓÞ ÔÞÚãÜÕÝâÐ ØÛØ ÛîÑÞÙ ÕÓÞ çÐáâØ 
ÑÕ× ßàÕÔÒÐàØâÕÛìÝÞÓÞ ßØáìÜÕÝÝÞÓÞ àÐ×àÕèÕÝØï ÚÞàßÞàÐæØØ Nokia ×ÐßàÕéÕÝÞ.
Nokia Ø Nokia Connecting People ïÒÛïîâáï ×ÐàÕÓØáâàØàÞÒÐÝÝëÜØ âÞÒÐàÝëÜØ ×ÝÐÚÐÜØ ºÞàßÞàÐæØØ Nokia. Bounce Ø 
Triple Pop ïÒÛïîâáï âÞÒÐàÝëÜØ ×ÝÐÚÐÜØ ºÞàßÞàÐæØØ Nokia. ½Ð×ÒÐÝØï ÔàãÓØå ßàÞÔãÚâÞÒ ØÛØ ÚÞÜßÐÝØÙ, ãÚÐ×ÐÝÝëÕ 
×ÔÕáì, ÜÞÓãâ Ñëâì âÞÒÐàÝëÜØ ×ÝÐÚÐÜØ ØÛØ âÞÒÐàÝëÜØ ØÜÕÝÐÜØ áÞÞâÒÕâáâÒãîéØå ÒÛÐÔÕÛìæÕÒ.
ºÞàßÞàÐæØï Nokia ßàØÔÕàÖØÒÐÕâáï ßÞÛØâØÚØ ÝÕßàÕàëÒÝÞÓÞ àÐ×ÒØâØï. ºÞàßÞàÐæØï Nokia ÞáâÐÒÛïÕâ ×Ð áÞÑÞÙ ßàÐÒÞ 
ÒÝÞáØâì ÛîÑëÕ Ø×ÜÕÝÕÝØï Ø ãÛãçèÕÝØï Ò ÛîÑÞÙ ßàÞÔãÚâ, ÞßØáÐÝÝëÙ Ò íâÞÜ ÔÞÚãÜÕÝâÕ, ÑÕ× ßàÕÔÒÐàØâÕÛìÝÞÓÞ 
ãÒÕÔÞÜÛÕÝØï.
ºÞàßÞàÐæØï Nokia ÝÕ ÝÕáÕâ ÞâÒÕâáâÒÕÝÝÞáâØ ×Ð ßÞâÕàî ÔÐÝÝëå ØÛØ ßàØÑëÛØ, Ð âÐÚÖÕ ×Ð ÛîÑÞÙ áßÕæØÐÛìÝëÙ, 
áÛãçÐÙÝëÙ, ßÞáÛÕÔãîéØÙ ØÛØ ÚÞáÒÕÝÝëÙ ãéÕàÑ, çÕÜ Ñë ÞÝ ÝØ ÑëÛ Òë×ÒÐÝ.
ÁÞÔÕàÖÐÝØÕ íâÞÓÞ ÔÞÚãÜÕÝâÐ ßàÕÔáâÐÒÛÕÝÞ ÝÐ ãáÛÞÒØïå "ÚÐÚ Õáâì". ºàÞÜÕ âàÕÑÞÒÐÝØÙ ÔÕÙáâÒãîéÕÓÞ 
×ÐÚÞÝÞÔÐâÕÛìáâÒÐ, ÝØÚÐÚØÕ ØÝëÕ ÓÐàÐÝâØØ, ÚÐÚ ïÒÝëÕ, âÐÚ Ø ßÞÔàÐ×ãÜÕÒÐÕÜëÕ, ÒÚÛîçÐï (ÝÞ ÝÕ ÞÓàÐÝØçØÒÐïáì) 
ÝÕïÒÝëÜØ ÓÐàÐÝâØïÜØ ÚÞÜÜÕàçÕáÚÞÙ æÕÝÝÞáâØ Ø ßàØÓÞÔÝÞáâØ ÔÛï ÞßàÕÔÕÛÕÝÝÞÙ æÕÛØ, ÝÕ ÚÐáÐîâáï âÞçÝÞáâØ, 
ÝÐÔÕÖÝÞáâØ ØÛØ áÞÔÕàÖÐÝØï íâÞÓÞ ÔÞÚãÜÕÝâÐ. ºÞàßÞàÐæØï Nokia ÞáâÐÒÛïÕâ ×Ð áÞÑÞÙ ßàÐÒÞ ßÕàÕáÜÐâàØÒÐâì ØÛØ 
Ø×ÜÕÝïâì áÞÔÕàÖØÜÞÕ ÔÐÝÝÞÓÞ ÔÞÚãÜÕÝâÐ Ò ÛîÑÞÕ ÒàÕÜï ÑÕ× ßàÕÔÒÐàØâÕÛìÝÞÓÞ ãÒÕÔÞÜÛÕÝØï.
´ÞáâãßÝÞáâì ÚÞÝÚàÕâÝëå ßàÞÔãÚâÞÒ ÜÞÖÕâ ×ÐÒØáÕâì Þâ àÕÓØÞÝÐ. ¾ÑàÐâØâÕáì Ú ÑÛØÖÐÙèÕÜã ßàÕÔáâÐÒØâÕÛî 
ºÞàßÞàÐæØØ Nokia.

´µº»°À°Æ¸Ï Á¾¾Â²µÂÁÂ²¸Ï 
ºÞÜßÐÝØï NOKIA CORPORATION ×ÐïÒÛïÕâ ßÞÔ áÒÞî ØáÚÛîçØâÕÛìÝãî ÞâÒÕâáâÒÕÝÝÞáâì, çâÞ Ø×ÔÕÛØÕ RAE-5N 
áÞÞâÒÕâáâÒãÕâ âàÕÑÞÒÐÝØïÜ ´ØàÕÚâØÒë ÁÞÒÕâÐ µÒàÞßë 1999/5/EC. ºÞßØî ´ÕÚÛÐàÐæØØ áÞÞâÒÕâáâÒØï ÜÞÖÝÞ ×ÐÓàã×Øâì 
á Web-áâàÐÝØæë http://www.nokia.com/phones/declaration_of_conformity/
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¿À°²¸»° ÂµÅ½¸º¸ ±µ·¾¿°Á½¾ÁÂ¸ 
¿àÞáìÑÐ Þ×ÝÐÚÞÜØâìáï á ßÕàÕçØáÛÕÝÝëÜØ ÝØÖÕ ßàÐÒØÛÐÜØ âÕåÝØÚØ 
ÑÕ×ÞßÐáÝÞáâØ. ½ÐàãèÕÝØÕ íâØå ßàÐÒØÛ ÜÞÖÕâ ßàØÒÕáâØ Ú ÞßÐáÝëÜ 
ßÞáÛÕÔáâÒØïÜ ØÛØ ßàÕáÛÕÔãÕâáï ßÞ ×ÐÚÞÝã. ±ÞÛÕÕ ßÞÔàÞÑÝÐï ØÝäÞàÜÐæØï 
ßàØÒÕÔÕÝÐ ÔÐÛÕÕ Ò ÝÐáâÞïéÕÜ àãÚÞÒÞÔáâÒÕ.

½Õ ÒÚÛîçÐÙâÕ ÑÕáßàÞÒÞÔÝëÙ âÕÛÕäÞÝ, ÕáÛØ ÕÓÞ ØáßÞÛì×ÞÒÐÝØÕ 
×ÐßàÕéÕÝÞ, ÜÞÖÕâ Òë×ÒÐâì ßÞÜÕåØ ØÛØ áÞ×ÔÐÒÐâì ãÓàÞ×ã 
ÑÕ×ÞßÐáÝÞáâØ.

±µ·¾¿°Á½¾ÁÂÌ ´¾À¾¶½¾³¾ ´²¸¶µ½¸Ï - ¿Àµ¶´µ ²Áµ³¾ ½Õ 
ßÞÛì×ãÙâÕáì ÚÞÜÜãÝØÚÐâÞàÞÜ ×Ð àãÛÕÜ ÔÒØÖãéÕÓÞáï ÐÒâÞÜÞÑØÛï.

À°´¸¾¿¾¼µÅ¸ ²áÕ ÑÕáßàÞÒÞÔÝëÕ âÕÛÕäÞÝë ßÞÔÒÕàÖÕÝë 
ÒÞ×ÔÕÙáâÒØî àÐÔØÞßÞÜÕå, ãåãÔèÐîéØå ÚÐçÕáâÒÞ áÒï×Ø.

²Ëº»ÎÇ°¹Âµ Âµ»µÄ¾½ ² ±¾»Ì½¸Æ°Å ÁâàÞÓÞ áÞÑÛîÔÐÙâÕ ÒáÕ 
ãáâÐÝÞÒÛÕÝÝëÕ ßàÐÒØÛÐ Ø ØÝáâàãÚæØØ. ²ëÚÛîçÐÙâÕ âÕÛÕäÞÝ àïÔÞÜ á 
ÜÕÔØæØÝáÚØÜ ÞÑÞàãÔÞÒÐÝØÕÜ.

²Ëº»ÎÇ°¹Âµ Âµ»µÄ¾½ ² Á°¼¾»µÂµ ±ÕáßàÞÒÞÔÝëÕ âÕÛÕäÞÝë 
ïÒÛïîâáï ØáâÞçÝØÚÞÜ àÐÔØÞßÞÜÕå.

²Ëº»ÎÇ°¹Âµ Âµ»µÄ¾½ ½° °²Â¾·°¿À°²¾Ç½ËÅ ÁÂ°½Æ¸ÏÅ ½Õ 
ßÞÛì×ãÙâÕáì âÕÛÕäÞÝÞÜ ÝÐ ÐÒâÞ×ÐßàÐÒÞçÝëå áâÐÝæØïå, Ð âÐÚÖÕ 
ÒÑÛØ×Ø âÞßÛØÒÝëå ØÛØ åØÜØçÕáÚØå ÞÑêÕÚâÞÒ.
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²Ëº»ÎÇ°¹Âµ Âµ»µÄ¾½ ² ¼µÁÂ°Å ²Ë¿¾»½µ½¸Ï ²·ÀË²½ËÅ 
À°±¾Â ½Õ ßÞÛì×ãÙâÕáì âÕÛÕäÞÝÞÜ Ò ÜÕáâÐå ßàÞÒÕÔÕÝØï Ò×àëÒÝëå 
àÐÑÞâ. ÁÞÑÛîÔÐÙâÕ ÒáÕ ãáâÐÝÞÒÛÕÝÝëÕ ÞÓàÐÝØçÕÝØï, ßàÐÒØÛÐ Ø 
ØÝáâàãÚæØØ.

¿À°²¸»Ì½¾ ¿¾»Ì·Ã¹ÂµÁÌ Âµ»µÄ¾½¾¼ ²Þ ÒàÕÜï àÐ×ÓÞÒÞàÐ 
âÕÛÕäÞÝ ÔÞÛÖÕÝ ÝÐåÞÔØâìáï Ò ÞÑëçÝÞÜ àÐÑÞçÕÜ ßÞÛÞÖÕÝØØ. ½Õ 
áÛÕÔãÕâ ÑÕ× ÝÕÞÑåÞÔØÜÞáâØ ßàØÚÐáÐâìáï Ú ÐÝâÕÝÝÕ.

¾±À°É°¹ÂµÁÌ Â¾»Ìº¾ º º²°»¸Ä¸Æ¸À¾²°½½Ë¼ 
Á¿µÆ¸°»¸ÁÂ°¼ º àÐÑÞâÐÜ ßÞ ÜÞÝâÐÖã Ø àÕÜÞÝâã 
àÐÔØÞÞÑÞàãÔÞÒÐÝØï ÔÞßãáÚÐîâáï âÞÛìÚÞ ÚÒÐÛØäØæØàÞÒÐÝÝëÕ 
áßÕæØÐÛØáâë..

¿À¸½°´»µ¶½¾ÁÂ¸ ¸ °ººÃ¼Ã»ÏÂ¾ÀË ¿àØÜÕÝïÙâÕ âÞÛìÚÞ 
àÕÚÞÜÕÝÔÞÒÐÝÝëÕ ÔÛï ÔÐÝÝÞÓÞ âÕÛÕäÞÝÐ ßàØÝÐÔÛÕÖÝÞáâØ Ø 
ÐÚÚãÜãÛïâÞàë. ½Õ ßÞÔÚÛîçÐÙâÕ Ú âÕÛÕäÞÝã ÝÕ ßàÕÔÝÐ×ÝÐçÕÝÝëÕ ÔÛï 
íâÞÓÞ ãáâàÞÙáâÒÐ.

²¾´¾ÁÂ¾¹º¾ÁÂÌ ºÞÜÜãÝØÚÐâÞà ÝÕ ïÒÛïÕâáï ÒÞÔÞÝÕßàÞÝØæÐÕÜëÜ. 
¾ÑÕàÕÓÐÙâÕ âÕÛÕäÞÝ Ø ßàØÝÐÔÛÕÖÝÞáâØ Þâ ßÞßÐÔÐÝØï ÒÛÐÓØ.

Àµ·µÀ²½¾µ º¾¿¸À¾²°½¸µ ÀÕÓãÛïàÝÞ áÞ×ÔÐÒÐÙâÕ àÕ×ÕàÒÝëÕ ÚÞßØØ 
ÒáÕå ÒÐÖÝëå ÔÐÝÝëå.

¿¾´º»ÎÇµ½¸µ º ´ÀÃ³¸¼ ÃÁÂÀ¾¹ÁÂ²°¼ ¿àØ ßÞÔÚÛîçÕÝØØ Ú 
âÕÛÕäÞÝã ÔàãÓØå ãáâàÞÙáâÒ Þ×ÝÐÚÞÜìâÕáì á ßàÐÒØÛÐÜØ âÕåÝØÚØ 
ÑÕ×ÞßÐáÝÞáâØ, ßàØÒÕÔÕÝÝëÜØ Ò àãÚÞÒÞÔáâÒÕ ßÞ íÚáßÛãÐâÐæØØ 
áÞÞâÒÕâáâÒãîéÕÓÞ ãáâàÞÙáâÒÐ. ½Õ ßÞÔÚÛîçÐÙâÕ Ú âÕÛÕäÞÝã 
ÝÕáÞÒÜÕáâØÜëÕ ãáâàÞÙáâÒÐ.
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¿¾ÁË»º° ¸ ¿À¸µ¼ ²Ë·¾²¾² ·ÐÚàÞÙâÕ ÚàëèÚã Ø ãÑÕÔØâÕáì Ò âÞÜ, 
çâÞ âÕÛÕäÞÝ ÒÚÛîçÕÝ Ø ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ áÕâØ. 
²ÒÕÔØâÕ âÕÛÕäÞÝÝëÙ ÝÞÜÕà (ÒÚÛîçÐï ÚÞÔ ×ÞÝë) Ø ÝÐÖÜØâÕ . ́ Ûï 
×ÐÒÕàèÕÝØï Òë×ÞÒÐ ÝÐÖÜØâÕ . ´Ûï ÞâÒÕâÐ ÝÐ Òë×ÞÒ ÝÐÖÜØâÕ 

.

²Ë·¾² Á»Ã¶±Ë ÍºÁÂÀµ½½¾¹ ¿¾¼¾É¸ ·ÐÚàÞÙâÕ ÚàëèÚã 
ÚÞÜÜãÝØÚÐâÞàÐ. ÃÑÕÔØâÕáì Ò âÞÜ, çâÞ âÕÛÕäÞÝ ÒÚÛîçÕÝ Ø ÝÐåÞÔØâáï 
Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ áÕâØ. ½ÐÖÜØâÕ ÚÛÐÒØèã  áâÞÛìÚÞ 
àÐ×, áÚÞÛìÚÞ ÝÕÞÑåÞÔØÜÞ ÔÛï ÞçØáâÚØ ÔØáßÛÕï (ÝÐßàØÜÕà, ÔÛï 
×ÐÒÕàèÕÝØï Òë×ÞÒÐ, ÒëåÞÔÐ Ø× ÜÕÝî Ø â. Ô.). ²ÒÕÔØâÕ âÕÛÕäÞÝÝëÙ 
ÝÞÜÕà áÛãÖÑë íÚáâàÕÝÝÞÙ ßÞÜÞéØ Ø ÝÐÖÜØâÕ . ÁÞÞÑéØâÕ Þ 
áÒÞÕÜ ÜÕáâÞÝÐåÞÖÔÕÝØØ. ½Õ ßàÕàëÒÐÙâÕ áÒï×Ø, ÝÕ ÔÞÖÔÐÒèØáì 
àÐ×àÕèÕÝØï.
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àãÚÞÒÞÔáâÒÞ
¿ÞáÛÕ àÐáßÐÚÞÒÚØ ÚÞÜßÛÕÚâÐ ßàÞÒÕàìâÕ ÝÐÛØçØÕ ßÕàÕçØáÛÕÝÝëå ÝØÖÕ 
ÚÞÜßÞÝÕÝâÞÒ:

• ´ÒÕ ÝÐÚÛÕÙÚØ ÝÐ ãßÐÚÞÒÚÕ ÚÞÜÜãÝØÚÐâÞàÐ
• ºÞÜÜãÝØÚÐâÞà Nokia 9210i Communicator
• ÀãÚÞÒÞÔáâÒÞ ßÞ íÚáßÛãÐâÐæØØ ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210i Communicator, 

ãáâÐÝÞÒÞçÝëÙ ßÕàÕçÕÝì (Settings checklist), ÞÑêÕÔØÝÕÝÝÞÕ ÚàÐâÚÞÕ 
àãÚÞÒÞÔáâÒÞ Ø àãÚÞÒÞÔáâÒÞ ßÞ ßàØÝÐÔÛÕÖÝÞáâïÜ, Ð âÐÚÖÕ àãÚÞÒÞÔáâÒÞ ßÞ 
ÔÞßÞÛÝØâÕÛìÝëÜ ßàØÛÞÖÕÝØïÜ (Add-on applications guide)

• °ÚÚãÜãÛïâÞà ßÞÒëèÕÝÝÞÙ ÕÜÚÞáâØ BLL-3
• ·ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ ACP-12
• ºÐÑÕÛì ØÝâÕàäÕÙáÐ RS-232 DLR-2L
• ºÞÜßÐÚâ-ÔØáÚ Nokia 9210i Communicator

ÃáÛÞÒØï, ÝÕÞÑåÞÔØÜëÕ ÔÛï àÐÑÞâë 
âÕÛÕäÞÝÐ
´Ûï ßÞáëÛÚØ Ø ßàØÕÜÐ âÕÛÕäÞÝÝëå Òë×ÞÒÞÒ Ø áÞÞÑéÕÝØÙ á ßÞÜÞéìî 
ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210i Communicator ÝÕÞÑåÞÔØÜÞ áÛÕÔãîéÕÕ:
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Þ ÁÞÒÕâ. ´Ûï âÞÓÞ, çâÞÑë 
ÒÞáßÞÛì×ÞÒÐâìáï 
ØÝâÕàÐÚâØÒÝÞÙ áßàÐÒÚÞÙ, 
ÞâÚàÞÙâÕ ÚàëèÚã Ø 
ÝÐÖÜØâÕ ÚÛÐÒØèã  
(ÁßàÐÒÚÐ).

• âÕÛÕäÞÝ ÒÚÛîçÕÝ;
• Ò âÕÛÕäÞÝ ãáâÐÝÞÒÛÕÝÐ ÔÕÙáâÒãîéÐï SIM-ÚÐàâÐ;
• âÕÛÕäÞÝ ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ áÕâØ.

² ÝÕÚÞâÞàëå áÞâÞÒëå áÕâïå Òë×ÞÒ ÜÕÖÔãÝÐàÞÔÝëå ÝÞÜÕàÞÒ áÛãÖÑë 
íÚáâàÕÝÝÞÙ ßÞÜÞéØ ÔÞßãáÚÐÕâáï Ø ÑÕ× SIM-ÚÐàâë. ´ÞßÞÛÝØâÕÛìÝãî 
ØÝäÞàÜÐæØî ÜÞÖÝÞ ßÞÛãçØâì ã ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ.

²°¶½¾µ ·°¼µÇ°½¸µ. ´Þáâãß Ú ÚÞÜÜãÝØÚÐâÞàã ÜÞÖÕâ Ñëâì ×ÐÚàëâ 
á ßÞÜÞéìî ÚÞÔÐ ÑÛÞÚØàÞÒÚØ. ºÞÔ ÑÛÞÚØàÞÒÚØ ßÞ ãÜÞÛçÐÝØî 
- 12345. ¿Þ áÞÞÑàÐÖÕÝØïÜ ÑÕ×ÞßÐáÝÞáâØ ÝÐáâÞïâÕÛìÝÞ 
àÕÚÞÜÕÝÔãÕâáï Ø×ÜÕÝØâì íâÞâ ÚÞÔ ÑÛÞÚØàÞÒÚØ. ÅàÐÝØâÕ ÚÞÔ 
Ò ÝÐÔÕÖÝÞÜ Ø ÑÕ×ÞßÐáÝÞÜ ÜÕáâÕ ÞâÔÕÛìÝÞ Þâ 
ÚÞÜÜãÝØÚÐâÞàÐ. ́ ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï ÞÑ Ø×ÜÕÝÕÝØØ 
ÚÞÔÐ ÑÛÞÚØàÞÒÚØ ßàØÒÕÔÕÝÐ Ò àÐ×ÔÕÛÕ ‘Security’ ÝÐ áâà. 216 
àãÚÞÒÞÔáâÒÐ ßÞ íÚáßÛãÐâÐæØØ. ÁÛÕÔãÕâ ØÜÕâì Ò ÒØÔã, çâÞ 
ÝØÚÐÚÐï áØáâÕÜÐ á ßàØÜÕÝÕÝØÕÜ ÚÞÔÐ ÔÞáâãßÐ ÝÕ ÜÞÖÕâ 
ÓÐàÐÝâØàÞÒÐâì ÐÑáÞÛîâÝÞÙ ×ÐéØâë Þâ 
ÝÕáÐÝÚæØÞÝØàÞÒÐÝÝÞÓÞ ØáßÞÛì×ÞÒÐÝØï ÚÞÜÜãÝØÚÐâÞàÐ.

¿ÕàÒÞÕ ÒÚÛîçÕÝØÕ
¿àØÜÕçÐÝØÕ. ¼ØÝØÐâîàÝëÕ ÚÐàâÞçÚØ SIM áÛÕÔãÕâ ÔÕàÖÐâì âÞÛìÚÞ Ò ÝÕ 

ÔÞáâãßÝëå ÔÛï ÔÕâÕÙ ÜÕáâÐå.

1 ·ÐÚàÞÙâÕ ÚàëèÚã ÚÞÜÜãÝØÚÐâÞàÐ Ø ãÑÕÔØâÕáì Ò âÞÜ, çâÞ âÕÛÕäÞÝ 
ÒëÚÛîçÕÝ. ² ßàÞâØÒÝÞÜ áÛãçÐÕ ÝÐÖÜØâÕ .
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Þ2 µáÛØ Ò ÚÞÜÜãÝØÚÐâÞà ãáâÐÝÞÒÛÕÝ ÐÚÚãÜãÛïâÞà, ÞâáÞÕÔØÝØâÕ ÕÓÞ. ½ÐÖÜØâÕ 

äØÚáÐâÞà Ò ÒÕàåÝÕÙ çÐáâØ ÐÚÚãÜãÛïâÞàÐ Ø ßÞÔÝØÜØâÕ ÐÚÚãÜãÛïâÞà Ø× 
ÓÝÕ×ÔÐ. ÁÜ. àØá. 1.

ÀØá. 1

3 ÃáâÐÝÞÒØâÕ SIM-ÚÐàâã Ò ÓÝÕ×ÔÞ SIM-ÚÐàâë: ßÞ×ÞÛÞçÕÝÝëÕ ÚÞÝâÐÚâë SIM-
ÚÐàâë ÔÞÛÖÝë Ñëâì ÞÑàÐéÕÝë ÒÝØ×, Ð áÚÞèÕÝÝëÙ ãÓÞÛ ÚÐàâë ÔÞÛÖÕÝ 
ÞÚÐ×Ðâìáï áßàÐÒÐ. ÁÜ. àØá. 2.
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ÀØá. 2

µáÛØ SIM-ÚÐàâÐ ßàÐÒØÛìÝÞ ãáâÐÝÞÒÛÕÝÐ Ò ÓÝÕ×ÔÞ, áÚÞèÕÝÝëÙ ãÓÞÛ ÞáâÐÕâáï 
áÝÐàãÖØ, ÚÐÚ ßÞÚÐ×ÐÝÞ ÝÐ àØá. 3.

ÀØá. 3 ÒØÔÕÝ áÚÞèÕÝÝëÙ ãÓÞÛ
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Þ4 ÃÑÕÔØâÕáì Ò âÞÜ, çâÞ SIM-ÚÐàâÐ àÐáßÞÛÞÖÕÝÐ ßàÐÒØÛìÝÞ, Ø ãáâÐÝÞÒØâÕ ÝÐ 

ÜÕáâÞ ÐÚÚãÜãÛïâÞà. µáÛØ ÐÚÚãÜãÛïâÞà ×ÐàïÖÕÝ ÝÕ ßÞÛÝÞáâìî ØÛØ ÝÕ 
×ÐàïÖÕÝ áÞÒáÕÜ, ßÕàÕÔ ÒÚÛîçÕÝØÕÜ ÚÞÜÜãÝØÚÐâÞàÐ àÕÚÞÜÕÝÔãÕâáï 
ßÞÔÚÛîçØâì Ú ÝÕÜã ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Ø ÝÐçÐâì ×ÐàïÔÚã ÐÚÚãÜãÛïâÞàÐ. 

5 ¾âÚàÞÙâÕ ÚàëèÚã ÚÞÜÜãÝØÚÐâÞàÐ. ºÞÜÜãÝØÚÐâÞà ÒëßÞÛÝïÕâ 
áÐÜÞßàÞÒÕàÚã, Ò âÕçÕÝØÕ ÚÞâÞàÞÙ ÝÐ ÔØáßÛÕÕ ÞâÞÑàÐÖÐÕâáï íÚàÐÝ 
ßàØÒÕâáâÒØï.

ÁÞÒÕâ. ²ëÑàÐâì áÒÞÙ 
ÓÞàÞÔ, çÐáÞÒÞÙ ßÞïá, 
äÞàÜÐâ ÒàÕÜÕÝØ Ø ÔÐâë 
ÜÞÖÝÞ Ò ÛîÑÞÕ ÒàÕÜï á 
ßÞÜÞéìî ßàØÛÞÖÕÝØÙ 
Date and time (´ÐâÐ Ø 
ÒàÕÜï) Ø Regional settings 
(ÀÕÓØÞÝÐÛìÝëÕ ÝÐáâàÞÙÚØ) 
Ò ÓàãßßÕ Control panel 
(¿ÐÝÕÛì ãßàÐÒÛÕÝØï).

6 µáÛØ ÚÞÜÜãÝØÚÐâÞà ßÞÔÔÕàÖØÒÐÕâ ÒëÑÞà àÐáÚÛÐÔÞÚ ÚÛÐÒØÐâãàë, ßÞáÛÕ 
×ÐÒÕàèÕÝØï áÐÜÞßàÞÒÕàÚØ ÝÐ ÔØáßÛÕÕ ßÞïÒØâáï ×ÐßàÞá ÝÐ ÒëÑÞà 
àÐáÚÛÐÔÚØ ÚÛÐÒØÐâãàë. ½ÐÖÜØâÕ ¾º ÔÛï ßÞÔâÒÕàÖÔÕÝØï ÒëÑÞàÐ 
àÐáÚÛÐÔÚØ.
² ßàÞâØÒÝÞÜ áÛãçÐÕ ÝÐ ÔØáßÛÕÕ ßÞïÒØâáï áßØáÞÚ ÓÞàÞÔÞÒ.

7 Á ßÞÜÞéìî ÚÛÐÒØè áÞ áâàÕÛÚÐÜØ ßàÞÚàãâØâÕ áßØáÞÚ ÔÞ áÒÞÕÓÞ ÓÞàÞÔÐ Ø 
ÝÐÖÜØâÕ OK. ¾âÚàÞÕâáï íÚàÐÝ, áÞÔÕàÖÐéØÙ âÕÚãéÕÕ ÒàÕÜï Ø ÔÐâã.
´Ûï ßÞØáÚÐ ÓÞàÞÔÐ ÜÞÖÝÞ ÒÒÕáâØ ÝÐ×ÒÐÝØÕ ÓÞàÞÔÐ Ò ßÞÛÕ ßÞØáÚÐ Ò ÝØÖÝÕÙ 
çÐáâØ íÚàÐÝÐ.

8 ¸×ÜÕÝØâÕ ÔÐâã Ø ÒàÕÜï, ÕáÛØ âàÕÑãÕâáï, Ø ÝÐÖÜØâÕ OK.
9 ·ÐâÕÜ ÜÞÖÝÞ Ø×ÜÕÝØâì ßÕàáÞÝÐÛìÝãî ØÝäÞàÜÐæØî ÒØ×ØâÝÞÙ ÚÐàâÞçÚØ. 

½ÐÖÜØâÕ OK.
µáÛØ Ò ÚÞÜÜãÝØÚÐâÞà ãáâÐÝÞÒÛÕÝÐ ÔÕÙáâÒãîéÐï SIM-ÚÐàâÐ, ØÝäÞàÜÐæØï 
ÒØ×ØâÝÞÙ ÚÐàâÞçÚØ ÜÞÖÕâ Ñëâì Ø×ÒÛÕçÕÝÐ á SIM-ÚÐàâë.

ÁÞÒÕâ. ´Ûï 
ßàØáÞÕÔØÝÕÝØï ÚÐàâØÝÚØ 
Ú áÒÞÕÙ ÒØ×ØâÝÞÙ ÚÐàâÞçÚÕ 
ÜÞÖÝÞ Ò ÛîÑÞÕ ÒàÕÜï 
ÒÞáßÞÛì×ÞÒÐâìáï 
ßàØÛÞÖÕÝØÕÜ Contacts 
(ºÞÝâÐÚâë).

10 ½Ð íÚàÐÝÕ ßÞïÒØâáï áÞÞÑéÕÝØÕ ÞÑ ãáßÕèÝÞÜ ×ÐÒÕàèÕÝØØ ßÕàÒÞÓÞ 
ÒÚÛîçÕÝØï. ½ÐÖÜØâÕ OK.

¿àØÜÕçÐÝØÕ. °ÚÚãÜãÛïâÞà ÝÕ ÒáâÐÝÕâ ÝÐ ÜÕáâÞ, ÕáÛØ SIM-ÚÐàâÐ 
ãáâÐÝÞÒÛÕÝÐ ÝÕßàÐÒØÛìÝÞ. ¿àØ ãáâÐÝÞÒÚÕ ÐÚÚãÜãÛïâÞàÐ ÝÕ 
ßàØÛÐÓÐÙâÕ çàÕ×ÜÕàÝëå ãáØÛØÙ! ÃÑÕÔØâÕáì Ò âÞÜ, SIM-ÚÐàâÐ 
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Þ ßàÐÒØÛìÝÞ ãáâÐÝÞÒÛÕÝÐ Ò ÓÝÕ×ÔÞ, ÚÐÚ ãÚÐ×ÐÝÞ ÒëèÕ. µáÛØ 
SIM-ÚÐàâÐ ãáâÐÝÞÒÛÕÝÐ ÝÕßàÐÒØÛìÝÞ, ÒëâïÝØâÕ ÕÕ Ø× ÓÝÕ×ÔÐ 
Ø ãáâÐÝÞÒØâÕ áÝÞÒÐ.

·ÐàïÔÚÐ ÐÚÚãÜãÛïâÞàÐ
ÁÞÒÕâ. ÂÕÚãéÕÕ 

áÞáâÞïÝØÕ ÐÚÚãÜãÛïâÞàÐ 
ÞâÞÑàÐÖÐÕâáï ÝÐ 
ØÝÔØÚÐâÞàÕ ãàÞÒÝï 
×ÐàïÔÚØ  ÝÐ ÔØáßÛÕÕ 
ÚÞÜÜãÝØÚÐâÞàÐ ØÛØ 
âÕÛÕäÞÝÐ.

1 ¿ÞÔÚÛîçØâÕ ßàÞÒÞÔ ×ÐàïÔÝÞÓÞ ãáâàÞÙáâÒÐ Ú àÐ×êÕÜã Ò ÝØÖÝÕÙ çÐáâØ 
ÚÞÜÜãÝØÚÐâÞàÐ, ÚÐÚ ßÞÚÐ×ÐÝÞ ÝÐ àØá. 4.

ÀØá. 4

2 ²ÚÛîçØâÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Ò áÕâÕÒãî àÞ×ÕâÚã (á áÞÞâÒÕâáâÒãîéØÜ 
ÝÐßàïÖÕÝØÕÜ). ² ßàÞæÕááÕ ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ ßÞÚÐ×ÐÝØï ØÝÔØÚÐâÞàÐ 
ãàÞÒÝï ×ÐàïÔÚØ ÝÐ ÔØáßÛÕÕ âÕÛÕäÞÝÐ æØÚÛØçÕáÚØ Ø×ÜÕÝïîâáï.

3 ¿Þ ÔÞáâØÖÕÝØØ ßÞÛÝÞÙ ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ ßÞÚÐ×ÐÝØï ØÝÔØÚÐâÞàÐ 
ßÕàÕáâÐîâ Ø×ÜÕÝïâìáï, Ø ÞâÞÑàÐÖÐîâáï ÒáÕ çÕâëàÕ íÛÕÜÕÝâÐ èÚÐÛë 
ØÝÔØÚÐâÞàÐ. ÂÕßÕàì ÜÞÖÝÞ ÞâÚÛîçØâì ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Þâ 
ÚÞÜÜãÝØÚÐâÞàÐ.
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Þ¿àØÜÕçÐÝØÕ. ²Þ ÒàÕÜï ×ÐàïÔÚØ ÚÞÜÜãÝØÚÐâÞàÞÜ ÜÞÖÝÞ ßÞÛì×ÞÒÐâìáï ÚÐÚ 

ÞÑëçÝÞ.

¸ÝâÕàäÕÙá ÚÞÜÜãÝØÚÐâÞàÐ
ÁÞÒÕâ. ¿àØ ×ÐÜÕÝÕ 

áâÐàÞÙ ÜÞÔÕÛØ 
ÚÞÜÜãÝØÚÐâÞàÐ Nokia ÝÐ 
ÚÞÜÜãÝØÚÐâÞà Nokia 9210i 
Communicator ßàÞçØâÐÙâÕ 
‘To transfer data from other 
devices’ ÝÐ áâà. 35 
àãÚÞÒÞÔáâÒÐ ßÞ 
íÚáßÛãÐâÐæØØ.

ÀØá. 5

¾áÝÞÒÝëÕ íÛÕÜÕÝâë ØÝâÕàäÕÙáÐ ÚÞÜÜãÝØÚÐâÞàÐ, ÒÚÛîçÐï ÔØáßÛÕÙ, ßÞÚÐ×ÐÝë 
ÝÐ àØá. 5. ´ØáßÛÕÙ ÒÚÛîçÐÕâáï ßàØ ÞâÚàëÒÐÝØØ ÚàëèÚØ ÚÞÜÜãÝØÚÐâÞàÐ. ½Ð 
ÔØáßÛÕÕ ÒÞááâÐÝÐÒÛØÒÐÕâáï ßàØÛÞÖÕÝØÕ, ÚÞâÞàÞÕ ÑëÛÞ ÐÚâØÒÝÞ Ò ßÞáÛÕÔÝØÙ 
àÐ×.

¿àØ ×ÐÚàëÒÐÝØØ ÚàëèÚØ ÔØáßÛÕÙ ÚÞÜÜãÝØÚÐâÞàÐ ÒëÚÛîçÐÕâáï, ßàØ íâÞÜ ÒáÕ 
ÔÐÝÝëÕ áÞåàÐÝïîâáï.

ÃßàÐÒÛïîéØÕ 
ÚÛÐÒØèØ

ºÛÐÒØèÐ áÞ 
áâàÕÛÚÐÜØºÛÐÒØèÐ ÜÕÝî

ºÛÐÒØÐâãàÐ
ºÛÐÒØèÐ áßàÐÒÚØ

ºÛÐÒØèØ 
ßàØÛÞÖÕÝØÙ

´ØáßÛÕÙ
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Þ ¿àØÜÕçÐÝØÕ. ÁßÕæØÐÛìÝÞ áÞåàÐÝïâì ØÝäÞàÜÐæØî ÝÕ âàÕÑãÕâáï. ¿àØ 
ÝÐÖÐâØØ ÚÛÐÒØèØ Close (·ÐÚàëâì), ßÕàÕÚÛîçÕÝØØ Ò ÔàãÓÞÕ 
ßàØÛÞÖÕÝØÕ, Ð âÐÚÖÕ ßàØ ×ÐÚàëÒÐÝØØ ÚàëèÚØ ÚÞÜÜãÝØÚÐâÞà 
Nokia 9210i Communicator ÐÒâÞÜÐâØçÕáÚØ áÞåàÐÝïÕâ ÒáÕ 
ÔÐÝÝëÕ.

ÀÐÑÞâÐ á ßàØÛÞÖÕÝØïÜØ
´Ûï ×ÐßãáÚÐ ßàØÛÞÖÕÝØÙ áÛãÖÐâ áÞÞâÒÕâáâÒãîéØÕ ÚÛÐÒØèØ Ò ÒÕàåÝÕÙ çÐáâØ 
ÚÛÐÒØÐâãàë. ¿àÕÔãáÜÞâàÕÝë áÛÕÔãîéØÕ ÚÛÐÒØèØ ßàØÛÞÖÕÝØÙ: 
Desk (ÀÐÑÞçØÙ áâÞÛ), Tel (ÂÕÛÕäÞÝ), Messaging (ÁÞÞÑéÕÝØï), Internet 
(¸ÝâÕàÝÕâ), Contacts (ºÞÝâÐÚâë), Calendar (ºÐÛÕÝÔÐàì), Office (¾äØá) Ø Extras 
(´ÞßÞÛÝØâÕÛìÝëÕ äãÝÚæØØ). 

ÁÞÒÕâ. ´Ûï ÒëÑÞàÐ 
ÐÚâØÒÝÞÓÞ ßàØÛÞÖÕÝØï 
ÜÞÖÝÞ ØáßÞÛì×ÞÒÐâì 
“¼ÕÝî ×ÐÔÐÝØÙ”, 
àÐáßÞÛÞÖÕÝÝÞÕ á ÛÕÒÞÙ 
áâÞàÞÝë ßÞÛÞáë ÜÕÝî.

´Ûï ßÕàÕÚÛîçÕÝØï ÝÐ ÔàãÓÞÕ ßàØÛÞÖÕÝØÕ ØÛØ Óàãßßã ßàØÛÞÖÕÝØÙ ÝÐÖÜØâÕ 
áÞÞâÒÕâáâÒãîéãî ÚÛÐÒØèã ßàØÛÞÖÕÝØï. ÍâÞ ÜÞÖÝÞ ÔÕÛÐâì ÔÐÖÕ ÒÞ ÒàÕÜï 
àÐ×ÓÞÒÞàÐ ßÞ âÕÛÕäÞÝã. ·ÐÚàëÒÐâì ÞÔÝÞ ßàØÛÞÖÕÝØÕ ßÕàÕÔ ×ÐßãáÚÞÜ ÔàãÓÞÓÞ 
ßàØÛÞÖÕÝØï ÝÕ âàÕÑãÕâáï. ²áÕ ÝÕÐÚâØÒÝëÕ ßàØÛÞÖÕÝØï ÞáâÐîâáï Ò äÞÝÞÒÞÜ 
áÞáâÞïÝØØ ÔÞ âÕå ßÞà, ßÞÚÐ ÞÝØ ÝÕ ÑãÔãâ ×ÐßãéÕÝë áÝÞÒÐ.
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ÞÍÛÕÜÕÝâë ÔØáßÛÕï

ÀØá. 6

¿àØÜÕà. µáÛØ 
Ò àãÚÞÒÞÔáâÒÕ 
ßàÕÔÛÐÓÐÕâáï, ÝÐßàØÜÕà, 
ÝÐÖÐâì Open (¾âÚàëâì), 
íâÞ Þ×ÝÐçÐÕâ, çâÞ 
ÝÕÞÑåÞÔØÜÞ ÝÐÖÐâì 
ãßàÐÒÛïîéãî ÚÛÐÒØèã, 
àÐáßÞÛÞÖÕÝÝãî ÝÐßàÞâØÒ 
ÚÞÜÐÝÔë Open.

¾áÝÞÒÝëÕ íÛÕÜÕÝâë ÔØáßÛÕï ßÞÚÐ×ÐÝë ÝÐ àØá. 6. ºÞÜÐÝÔë ÒáÕÓÔÐ 
áÞÞâÒÕâáâÒãîâ çÕâëàÕÜ ÚÞÜÐÝÔÝëÜ ÚÛÐÒØèÐÜ á ßàÐÒÞÙ áâÞàÞÝë ÔØáßÛÕï. 
² àãÚÞÒÞÔáâÒÐå ÚÞÜÐÝÔë ÒëÔÕÛÕÝë ÖØàÝëÜ èàØäâÞÜ, Ð íÛÕÜÕÝâë, ÚÞâÞàëÕ 
ÒëÒÞÔïâáï ÝÐ ÔØáßÛÕÙ, ÒëÔÕÛÕÝë ÚãàáØÒÞÜ.

¿ÞÛÞáÐ ßàÞÚàãâÚØ ãÚÐ×ëÒÐÕâ, çâÞ áßØáÞÚ áÞÔÕàÖØâ ÑÞÛìèÕ íÛÕÜÕÝâÞÒ, çÕÜ 
ßÞÜÕéÐÕâáï ÝÐ ÔØáßÛÕÕ. ´Ûï ßàÞÚàãâÚØ Ø×ÞÑàÐÖÕÝØï ÝÐ ÔØáßÛÕÕ áÛãÖØâ 
ÚÛÐÒØèÐ áÞ áâàÕÛÚÐÜØ, àÐáßÞÛÞÖÕÝÝÐï Ò ßàÐÒÞÜ ÝØÖÝÕÜ ãÓÛã ÚÛÐÒØÐâãàë.

µáÛØ Ò ÝØÖÝÕÙ çÐáâØ ÔØáßÛÕï ÞâÞÑàÐÖÐÕâáï ßÞÛÕ ßÞØáÚÐ, Ò íâÞ ßÞÛÕ ÜÞÖÝÞ 
á ÚÛÐÒØÐâãàë ÒÒÕáâØ âÕÚáâ ÔÛï ßÞØáÚÐ âàÕÑãÕÜÞÓÞ íÛÕÜÕÝâÐ.

µáÛØ ÝÐ ÔØáßÛÕÕ ÞâÞÑàÐÖÐÕâáï ÑÞÛÕÕ ÞÔÝÞÓÞ ÞÚÝÐ, ÒëÑàÐÝÝÞÕ ÞÚÝÞ ÒáÕÓÔÐ 
ÒëÔÕÛÕÝÞ.

ÍâÞâ íÛÕÜÕÝâ 
ÒëÑàÐÝ

¿àÐÒÞÕ ÞÚÝÞ; ÔÛï ÒëÔÕÛÕÝØï íâÞÓÞ 
ÞÚÝÐ ÝÐÖÜØâÕ ÚÛÐÒØèã Tab

»ÕÒÞÕ ÞÚÝÞ 
ÒëÔÕÛÕÝÞ

ÁÒÕÔÕÝØï ÞÑ 
íÛÕÜÕÝâÕ

ºÞÜÐÝÔë, ÚÞâÞàëÕ 
ÜÞÖÝÞ ÒëßÞÛÝØâì
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Þ ´Ûï ßÕàÕÜÕéÕÝØï ÜÕÖÔã ÒëÑàÐÝÝëÜØ ÞÚÝÐÜØ Ø ÒëÑàÐÝÝëÜØ íÛÕÜÕÝâÐÜØ 
áÛãÖØâ ÚÛÐÒØèÐ áÞ áâàÕÛÚÐÜØ.

´Ûï ÔÞáâãßÐ Ú ÚÞÜÐÝÔÐÜ ÜÕÝî ÝÐÖÜØâÕ ÚÛÐÒØèã Menu.

½ÐáâàÞÙÚÐ ÚÞÝäØÓãàÐæØØ
´Ûï ÔÞáâãßÐ Ú áÕâØ ¸ÝâÕàÝÕâ, ãáÛãÓÐÜ WAP Ø ãÔÐÛÕÝÝÞÜã ßÞçâÞÒÞÜã ïéØÚã 
ÝÕÞÑåÞÔØÜÞ ÝÐáâàÞØâì áÞÞâÒÕâáâÒãîéØÕ ßÐàÐÜÕâàë. 

¿àØÜÕçÐÝØÕ. ´Ûï ãßàÞéÕÝØï ßàÞæÕÔãàë ÝÐáâàÞÙÚØ Ú ÚÞÜÜãÝØÚÐâÞàã 
ßàØÛÐÓÐÕâáï ÃáâÐÝÞÒÞçÝëÙ ßÕàÕçÕÝì (Settings checklist). 
² íâÞÜ ÔÞÚãÜÕÝâÕ ãÚÐ×ÐÝÞ, ÚÐÚÐï ØÝäÞàÜÐæØï âàÕÑãÕâáï, ÓÔÕ 
ÕÕ Ò×ïâì Ø ÚÐÚ ÒÒÕáâØ Ò ßÐÜïâì ÚÞÜÜãÝØÚÐâÞàÐ. ¾Ñï×ÐâÕÛìÝÞ 
×ÐßØèØâÕ íâã ßÞÛÕ×Ýãî áßàÐÒÞçÝãî ØÝäÞàÜÐæØî Ò 
ãáâÐÝÞÒÞçÝëÙ ßÕàÕçÕÝì: ÒßÞáÛÕÔáâÒØØ íâÐ ØÝäÞàÜÐæØï 
ßÞâàÕÑãÕâáï ßàØ ×ÐßàÞáÕ ÝÕÞÑåÞÔØÜëå ÔÐÝÝëå Þâ 
ßÞáâÐÒéØÚÐ ãáÛãÓ.

1 ½ÐÖÜØâÕ ÚÛÐÒØèã ßàØÛÞÖÕÝØï Extras ÝÐ ÚÛÐÒØÐâãàÕ ÚÞÜÜãÝØÚÐâÞàÐ.
2 Á ßÞÜÞéìî ÚÛÐÒØèØ áÞ áâàÕÛÚÐÜØ ÒëÑÕàØâÕ ×ÝÐçÞÚ Internet startup 

(¿ÐàÐÜÕâàë ¸ÝâÕàÝÕâ) Ø ÝÐÖÜØâÕ Open (¾âÚàëâì). ½Ð ÔØáßÛÕÕ ßÞïÒïâáï 
âàØ ×ÝÐçÚÐ: Internet access (´Þáâãß Ú ̧ ÝâÕàÝÕâ), WAP access (´Þáâãß Ú ãáÛãÓÐÜ 
WAP) Ø Mail account (´Þáâãß Ú ßÞçâÞÒÞÜã ïéØÚã).

3 ²ëÑÕàØâÕ ×ÝÐçÞÚ Internet access Ø ÝÐÖÜØâÕ Open. ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ 
ÞÚÝÞ.
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ÀØá. 7

ÁÞÒÕâ. ´Ûï ßÞÛãçÕÝØï 
áßàÐÒÞçÝÞÙ ØÝäÞàÜÐæØØ Þ 
ÔÐÝÝëå, ÚÞâÞàëÕ 
ÝÕÞÑåÞÔØÜÞ ÒÒÕáâØ Ò íâÞÜ 
Ø áÛÕÔãîéØå ÔØÐÛÞÓÐå, 
ÝÐÖÜØâÕ ÚÛÐÒØèã , 
çâÞÑë Òë×ÒÐâì áßàÐÒÚã; 
áÜ. âÐÚÖÕ àãÚÞÒÞÔáâÒÞ ßÞ 
íÚáßÛãÐâÐæØØ.

4 ²ÒÕÔØâÕ ÝÕÞÑåÞÔØÜëÕ ÔÐÝÝëÕ Ø ÝÐÖÜØâÕ Advanced settings 
(´ÞßÞÛÝØâÕÛìÝëÕ ßÐàÐÜÕâàë). ¾âÚàÞÕâáï çÕâëàÕåáâàÐÝØçÝÞÕ ÔØÐÛÞÓÞÒÞÕ 
ÞÚÝÞ.

ÀØá. 8

²ÒÕÔØâÕ ÔÐÝÝëÕ ÝÐ ÚÐÖÔÞÙ áâàÐÝØæÕ. 
ÁÞÒÕâ. ´Ûï ßÕàÕåÞÔÐ Þâ 

ÞÔÝÞÙ áâàÐÝØæÕ Ú ÔàãÓÞÙ 
ÝÐÖÜØâÕ ÚÛÐÒØèã Menu.

5 ½Ð áâàÐÝØæÕ Other (¿àÞçÕÕ) ÝÐÖÜØâÕ Address options (¿ÐàÐÜÕâàë ÐÔàÕáÐ). 
¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ.
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ÀØá. 9

·ÐÔÐÙâÕ ÐÔàÕáÐ IP Ø DNS.
´Ûï ÒÞ×ÒàÐâÐ Ò ÞÚÝÞ á âàÕÜï ×ÝÐçÚÐÜØ ÝÐÖÜØâÕ Done (³ÞâÞÒÞ).

ÁÞÒÕâ. ¿ÞÔàÞÑÝÐï 
ØÝäÞàÜÐæØï ßàØÒÕÔÕÝÐ 
Ò ÓÛÐÒÕ “¸ÝâÕàÝÕâ” 
àãÚÞÒÞÔáâÒÐ ßÞ 
íÚáßÛãÐâÐæØØ.

6 ²ëÑÕàØâÕ ×ÝÐçÞÚ WAP access Ø ÝÐÖÜØâÕ Open. ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ.

ÀØá. 10

²ÒÕÔØâÕ ÔÐÝÝëÕ ÝÐ ÚÐÖÔÞÙ áâàÐÝØæÕ Ø ÝÐÖÜØâÕ Close ÔÛï ÒÞ×ÒàÐâÐ Ò ÞÚÝÞ 
á âàÕÜï ×ÝÐçÚÐÜØ.

ÁÞÒÕâ. ¿ÞÔàÞÑÝÐï 
ØÝäÞàÜÐæØï ßàØÒÕÔÕÝÐ 
Ò ÓÛÐÒÕ “ÁÞÞÑéÕÝØï” 
àãÚÞÒÞÔáâÒÐ ßÞ 
íÚáßÛãÐâÐæØØ.

7 ²ëÑÕàØâÕ Mail account Ø ÝÐÖÜØâÕ Open. ¾âÚàÞÕâáï çÕâëàÕåáâàÐÝØçÝÞÕ 
ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ.
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ÀØá. 11

²ÒÕÔØâÕ ÔÐÝÝëÕ ÝÐ ÚÐÖÔÞÙ áâàÐÝØæÕ Ø ÝÐÖÜØâÕ Done ÔÛï ÒÞ×ÒàÐâÐ Ò ÞÚÝÞ 
á âàÕÜï ×ÝÐçÚÐÜØ.

¿àØÜÕçÐÝØÕ. ´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï Þ ßÐàÐÜÕâàÐå ÔÞáâãßÐ Ú áÕâØ 
¸ÝâÕàÝÕâ Ø àÐÑÞâë á íÛÕÚâàÞÝÝÞÙ ßÞçâÞÙ ßàØÒÕÔÕÝÐ Ò ÓÛÐÒÐå 
“¸ÝâÕàÝÕâ” (Internet) Ø “ÁÞÞÑéÕÝØï” (Messaging) àãÚÞÒÞÔáâÒÐ 
ßÞ íÚáßÛãÐâÐæØØ.

¿ÞÔÚÛîçÕÝØÕ Ú ¿º
¿ÞÔÚÛîçÕÝØÕ ÚÞÜÜãÝØÚÐâÞàÐ Ú áÞÒÜÕáâØÜÞÜã ÝÐáâÞÛìÝÞÜã ØÛØ 
ßÞàâÐâØÒÝÞÜã ¿º ÞáãéÕáâÒÛïÕâáï á ßÞÜÞéìî ßàÞÓàÐÜÜë PC Suite ÔÛï 
ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210i, ÚÞâÞàÐï ÝÐåÞÔØâáï ÝÐ ÚÞÜßÐÚâ-ÔØáÚÕ Ø× 
ÚÞÜßÛÕÚâÐ ßÞáâÐÒÚØ ÚÞÜÜãÝØÚÐâÞàÐ. ½Ð ÚÞÜßÐÚâ-ÔØáÚÕ Ò àÐ×ÔÕÛÕ Using Nokia 
9210i Communicator (¸áßÞÛì×ÞÒÐÝØÕ ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210i) âÐÚÖÕ 
ÝÐåÞÔØâáï ÀãÚÞÒÞÔáâÒÞ ßÞÛì×ÞÒÐâÕÛï ßàÞÓàÐÜÜÝÞÓÞ ÞÑÕáßÕçÕÝØï PC Suite.

¿àØÜÕçÐÝØÕ. ½Õ ßëâÐÙâÕáì ÞÔÝÞÒàÕÜÕÝÝÞ ØáßÞÛì×ÞÒÐâì ÝÐ ÞÔÝÞÜ Ø âÞÜ 
ÖÕ ßÕàáÞÝÐÛìÝÞÜ ØÛØ ßÞàâÐâØÒÝÞÜ ÚÞÜßìîâÕàÕ 
ßàÞÓàÐÜÜÝëÕ ßÐÚÕâë PC Suite ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ Nokia 
9210i Ø PC Suite ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210 ØÛØ 9290. 
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Þ µáÛØ ÝÐ ÚÞÜßìîâÕàÕ ãÖÕ ãáâÐÝÞÒÛÕÝ ßàÞÓàÐÜÜÝëÙ ßÐÚÕâ PC 
Suite ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210 ØÛØ 9290, ÝÕÞÑåÞÔØÜÞ 
áÝÐçÐÛÐ ãÔÐÛØâì ÕÓÞ, Ð ×ÐâÕÜ ãáâÐÝÞÒØâì ßàÞÓàÐÜÜÝëÙ ßÐÚÕâ 
PC Suite ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210i.

¿àÞÓàÐÜÜÝÞÕ ßàØÛÞÖÕÝØÕ PC Suite ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210i 
ßàÕÔÝÐ×ÝÐçÕÝÞ ÔÛï ãáâÐÝÞÒÚØ ÝÐ ßÕàáÞÝÐÛìÝëÙ ÚÞÜßìîâÕà á ÞßÕàÐæØÞÝÝÞÙ 
áØáâÕÜÞÙ Windows 95/98, 2000 ØÛØ NT. ¾ÝÐ ØÝâÕÓàØàãÕâ äÐÙÛÞÒãî áØáâÕÜã 
ÚÞÜÜãÝØÚÐâÞàÐ Ò äÐÙÛÞÒãî áØáâÕÜã ÚÞÜßìîâÕàÐ, ßÞ×ÒÞÛïï ÞßÕàÐâØÒÝÞ 
ßÕàÕÜÕéÐâì, ÚÞßØàÞÒÐâì, ßÕàÕØÜÕÝÞÒëÒÐâì Ø ãÔÐÛïâì äÐÙÛë Ø ßÐßÚØ 
ÚÞÜÜãÝØÚÐâÞàÐ Ø ¿º.

Á ßÞÜÞéìî ßàÞÓàÐÜÜë PC Suite ÜÞÖÝÞ áØÝåàÞÝØ×ØàÞÒÐâì ÔÐÝÝëÕ 
ßàØÛÞÖÕÝØÙ (ÝÐßàØÜÕà, ÚÞÝâÐÚâÞÒ Ø íÛÕÚâàÞÝÝÞÙ ßÞçâë) ÜÕÖÔã 
ÚÞÜÜãÝØÚÐâÞàÞÜ Ø ¿º, Ð âÐÚÖÕ áÞ×ÔÐÒÐâì àÕ×ÕàÒÝëÕ ÚÞßØØ ÔÐÝÝëå ÝÐ ÔØáÚÕ 
¿º. ¼ÞÖÝÞ âÐÚÖÕ ÐÒâÞÜÐâØ×ØàÞÒÐâì áØÝåàÞÝØ×ÐæØî Ø àÕ×ÕàÒÝÞÕ ÚÞßØàÞÒÐÝØÕ, 
âÞÓÔÐ íâØ ÞßÕàÐæØØ ÑãÔãâ ÒëßÞÛÝïâìáï Ò ×ÐÔÐÝÝÞÕ ÒàÕÜï ØÛØ ßàØ 
ßÞÔÚÛîçÕÝØØ ÚÞÜÜãÝØÚÐâÞàÐ Ú ¿º.

¿àÞÓàÐÜÜã PC Suite ÜÞÖÝÞ ×ÐßãáâØâì Ø ÑÕ× ßÞÔÚÛîçÕÝØï ÚÞÜÜãÝØÚÐâÞàÐ 
Ú ÚÞÜßìîâÕàã (ÐÒâÞÝÞÜÝëÙ àÕÖØÜ). ¿àØ ÞçÕàÕÔÝÞÜ áÞÕÔØÝÕÝØØ ÔÒãå 
ãáâàÞÙáâÒ Ø×ÜÕÝÕÝÝëÕ ÔÐÝÝëÕ ÜÞÖÝÞ ßÕàÕÝÕáâØ Ø× ¿º Ò ÚÞÜÜãÝØÚÐâÞà Ø 
ÞÑàÐâÝÞ.

¿Àµ´Ã¿Àµ¶´µ½¸µ. ÁÛÕÔãÕâ ßÞÛì×ÞÒÐâìáï âÞÛìÚÞ âÐÚØÜØ ØáâÞçÝØÚÐÜØ 
ßàÞÓàÐÜÜÝÞÓÞ ÞÑÕáßÕçÕÝØï, ÚÞâÞàëÕ ÓÐàÐÝâØàãîâ 
ÐÔÕÚÒÐâÝãî ×ÐéØâã Þâ ÚÞÜßìîâÕàÝëå ÒØàãáÞÒ Ø 
ÔàãÓØå ßàÞÓàÐÜÜ, ÝÐÝÞáïéØå ãéÕàÑ. ÁÜ. àÐ×ÔÕÛ 
“ÃßàÐÒÛÕÝØÕ áÕàâØäØÚÐâÐÜØ” àãÚÞÒÞÔáâÒÐ ßÞ 
íÚáßÛãÐâÐæØØ.
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1 ¿àØ ßÞÔÚÛîçÕÝØØ ÚÐÑÕÛï RS-232 ÑÞÛìèØÙ àÐ×êÕÜ ÒÚÛîçÐÕâáï 
Ò ßÞáÛÕÔÞÒÐâÕÛìÝëÙ ßÞàâ (COM) ÚÞÜßìîâÕàÐ, Ð ÜÕÝìèØÙ àÐ×êÕÜ — 
Ú àÐ×êÕÜã Ò ÝØÖÝÕÙ çÐáâØ ÚÞÜÜãÝØÚÐâÞàÐ. 

2 ¿àØ ØáßÞÛì×ÞÒÐÝØØ ØÝäàÐÚàÐáÝÞÓÞ ßÞàâÐ ØÛØ ßÞáÛÕÔÞÒÐâÕÛìÝÞÓÞ ßÞàâÐ, 
ÞâÛØçÝÞÓÞ Þâ COM1, ÔÒÐÖÔë éÕÛÚÝØâÕ Üëèìî ÝÐ ×ÝÐçÚÕ áÞÕÔØÝÕÝØï PC 
Suite Ò ßÐÝÕÛØ ×ÐÔÐç Windows Ø ÒëÑÕàØâÕ âàÕÑãÕÜëÙ ßÞàâ.

3 ¾âÚàÞÙâÕ ÚÞÜÜãÝØÚÐâÞà.
4 ¿àØ ØáßÞÛì×ÞÒÐÝØØ ØÝäàÐÚàÐáÝÞÓÞ áÞÕÔØÝÕÝØï ãÑÕÔØâÕáì Ò âÞÜ, çâÞ ¸º-

ßÞàâ ÚÞÜÜãÝØÚÐâÞàÐ ÝÐßàÐÒÛÕÝ Ò áâÞàÞÝã ¸º-ßÞàâÐ ÚÞÜßìîâÕàÐ. ´Ûï 
ÒÚÛîçÕÝØï ¸º-ßÞàâÐ ÚÞÜÜãÝØÚÐâÞàÐ ÝÐÖÜØâÕ Chr +  (ÚÛÐÒØèÐ áÞ 
×ÝÐçÚÞÜ ØÝäàÐÚàÐáÝÞÓÞ áÞÕÔØÝÕÝØï). ´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï Þ 
àÐÑÞâÕ á ¸º-ßÞàâÞÜ ÚÞÜÜãÝØÚÐâÞàÐ ßàØÒÕÔÕÝÐ Ò àãÚÞÒÞÔáâÒÕ ßÞ 
íÚáßÛãÐâÐæØØ.

5 ·ÐßãáâØâÕ ÝÐ ¿º ßàÞÓàÐÜÜã PC Suite. 
ÂÕßÕàì ßàÞÓàÐÜÜÐ PC Suite ÐÒâÞÜÐâØçÕáÚØ ãáâÐÝÞÒØâ áÞÕÔØÝÕÝØÕ 
á ÚÞÜÜãÝØÚÐâÞàÞÜ.

¿àØÛÞÖÕÝØÕ Desk
¿àØÛÞÖÕÝØÕ Desk (ÀÐÑÞçØÙ áâÞÛ) ßàÕÔÝÐ×ÝÐçÕÝÞ ÔÛï ãßàÐÒÛÕÝØï Ø 
ØáßÞÛì×ÞÒÐÝØï àÐ×ÛØçÝëå ááëÛÞÚ ÝÐ ÔàãÓØÕ ßàØÛÞÖÕÝØï Ø ßàÞÓàÐÜÜÝÞÕ 
ÞÑÕáßÕçÕÝØÕ ÔàãÓØå Ø×ÓÞâÞÒØâÕÛÕÙ. ÁáëÛÚØ áÞ×ÔÐîâáï Ò áÞÞâÒÕâáâÒãîéØå 
ßàØÛÞÖÕÝØïå.
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Þ ´Ûï áÞ×ÔÐÝØï ááëÛÚØ
1 ¾âÚàÞÙâÕ ÞÑêÕÚâ Ò áÞÞâÒÕâáâÒãîéÕÜ ßàØÛÞÖÕÝØØ. 
2 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ Add to Desk (´ÞÑÐÒØâì ÝÐ àÐÑÞçØÙ 

áâÞÛ).

´Ûï ÒÒÞÔÐ ×ÐÜÕâÞÚ
1 ½ÐÖÜØâÕ Write note (½ÐßØáÐâì ×ÐÜÕâÚã). ¾âÚàÞÕâáï ßàÞáâÞÙ âÕÚáâÞÒëÙ 

àÕÔÐÚâÞà.
2 ²ÒÕÔØâÕ ×ÐÜÕâÚã.
3 ½ÐÖÜØâÕ Close (·ÐÚàëâì), çâÞÑë áÞåàÐÝØâì ÔÞÚãÜÕÝâ. ¿ÞáÛÕ íâÞÓÞ ×ÐÜÕâÚÐ 

ßÞïÒØâáï ÝÐ ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Desk.

¿àØÛÞÖÕÝØÕ Telephone
¿àØÛÞÖÕÝØÕ Telephone (ÂÕÛÕäÞÝ) ØáßÞÛì×ãÕâáï ÔÛï ßÞáëÛÚØ Ø ßàØÕÜÐ 
ÓÞÛÞáÞÒëå Òë×ÞÒÞÒ, Ð âÐÚÖÕ ÔÛï ÝÐáâàÞÙÚØ ßÐàÐÜÕâàÞÒ âÕÛÕäÞÝÐ. ´Ûï 
×ÐßãáÚÐ ßàØÛÞÖÕÝØï Telephone ÞâÚàÞÙâÕ ÚàëèÚã ÚÞÜÜãÝØÚÐâÞàÐ Ø ÝÐÖÜØâÕ 
ÚÛÐÒØèã ßàØÛÞÖÕÝØï Tel ÝÐ ÚÛÐÒØÐâãàÕ. ¼ÝÞÓØÕ Ø× ÞßÕàÐæØÙ, ÒëßÞÛÝïÕÜëå Ò 
ßàØÛÞÖÕÝØØ Telephone, âÐÚÖÕ ÔÞáâãßÝë á âÕÛÕäÞÝÐ (ÝÐ ÛØæÕÒÞÙ áâÞàÞÝÕ 
ÚàëèÚØ ÚÞÜÜãÝØÚÐâÞàÐ).

´Ûï ßÞáëÛÚØ âÕÛÕäÞÝÝëå Òë×ÞÒÞÒ ÝÕÞÑåÞÔØÜÞ áÛÕÔãîéÕÕ:

• âÕÛÕäÞÝ ÒÚÛîçÕÝ;
• Ò ÚÞÜÜãÝØÚÐâÞà ãáâÐÝÞÒÛÕÝÐ ÔÕÙáâÒãîéÐï SIM-ÚÐàâÐ;
• âÕÛÕäÞÝ ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ áÕâØ.
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Þ¿ÞáëÛÚÐ Òë×ÞÒÐ

´Ûï ßÞáëÛÚØ Òë×ÞÒÐ ÜÞÖÝÞ ÒÞáßÞÛì×ÞÒÐâìáï ÞÔÝØÜ Ø× ÔÒãå áßÞáÞÑÞÒ:

• ²ëÑÕàØâÕ ÚÞÝâÐÚâ Ø× ÚÐâÐÛÞÓÐ Telephone Ø ÝÐÖÜØâÕ Call (²ë×ÞÒ). µáÛØ 
ÚÞÝâÐÚâ áÞÔÕàÖØâ âÞÛìÚÞ ÞÔØÝ âÕÛÕäÞÝÝëÙ ÝÞÜÕà, Òë×ÞÒ ÞáãéÕáâÒÛïÕâáï 
áàÐ×ã.
µáÛØ ÚÞÝâÐÚâ áÞÔÕàÖØâ ÝÕáÚÞÛìÚÞ âÕÛÕäÞÝÝëå ÝÞÜÕàÞÒ, ÞâÚàëÒÐÕâáï 
áßØáÞÚ ÝÞÜÕàÞÒ; ÒëÑÕàØâÕ ÝÞÜÕà Ø× áßØáÚÐ Ø ÝÐÖÜØâÕ Call.

• ²ÒÕÔØâÕ âÕÛÕäÞÝÝëÙ ÝÞÜÕà Ò ßÞÛÕ ßÞØáÚÐ Ò ÝØÖÝÕÙ çÐáâØ ÓÛÐÒÝÞÓÞ íÚàÐÝÐ 
Ø ÝÐÖÜØâÕ Call.

¾âÒÕâ ÝÐ Òë×ÞÒ
¿àØ ßÞáâãßÛÕÝØØ Òë×ÞÒÐ ÝÐ ÔØáßÛÕÕ ßÞïÒÛïÕâáï áÞÞÑéÕÝØÕ. ² ×ÐÒØáØÜÞáâØ Þâ 
ßÐàÐÜÕâàÞÒ ßàÞäØÛï ÚÞÜÜãÝØÚÐâÞà ÜÞÖÕâ ßÞÔÐÒÐâì ×ÒãÚÞÒÞÙ áØÓÝÐÛ Òë×ÞÒÐ. 

´Ûï ÞâÒÕâÐ ÝÐ Òë×ÞÒ ÝÐÖÜØâÕ Answer (¾âÒÕâØâì); 
ÕáÛØ ÞâÒÕçÐâì ÝÐ Òë×ÞÒ ÝÕ âàÕÑãÕâáï, ÝÐÖÜØâÕ Reject (¾âÚÛÞÝØâì).

¿àÞäØÛì ¿ÞÛÕâ

¿àÞäØÛì "¿ÞÛÕâ" (Flight) ßÞ×ÒÞÛïÕâ ßàÕÔÞâÒàÐâØâì áÛãçÐÙÝÞÕ ÒÚÛîçÕÝØÕ 
âÕÛÕäÞÝÐ Ò áÐÜÞÛÕâÕ. ´Ûï ÒëÑÞàÐ ßàÞäØÛï "¿ÞÛÕâ":

1 ½Ð ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Telephone ÝÐÖÜØâÕ ÚÛÐÒØèã Menu, 
ßàÞÚàãâØâÕ ßÞÛÞáã ÜÕÝî ÔÞ ×ÝÐçÚÐ Profiles  (¿àÞäØÛØ), ×ÐâÕÜ ÒëÔÕÛØâÕ 
ßãÝÚâ Flight.

2 ½ÐÖÜØâÕ Select (²ëÑàÐâì).
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Þ ¿àØ ÒëÑàÐÝÝÞÜ ßàÞäØÛÕ "¿ÞÛÕâ" ÒÞ×ÜÞÖÝÞ ÒëßÞÛÝÕÝØÕ âÕå ×ÐÔÐÝØÙ, 
ÚÞâÞàëÕ ÝÕ âàÕÑãîâ ßÞÔÚÛîçÕÝØï Ú áÞâÞÒÞÙ áÕâØ. ½ÐßàØÜÕà, ÜÞÖÝÞ çØâÐâì 
ßÞÛãçÕÝÝëÕ àÐÝÕÕ ßØáìÜÐ, ßØáÐâì ßØáìÜÐ, ×ÐÜÕâÚØ, ÚÞàÞâÚØÕ áÞÞÑéÕÝØï, 
äÐÚáØÜØÛìÝëÕ áÞÞÑéÕÝØï ØÛØ àÕÔÐÚâØàÞÒÐâì ÚÐÛÕÝÔÐàì. ¿ÞÚØÝãÒ áÐÜÞÛÕâ, 
ÝÐÖÜØâÕ Exit profile (²ëÙâØ Ø× ßàÞäØÛï) Ò ßàØÛÞÖÕÝØØ Telephone, çâÞÑë 
ÒëÚÛîçØâì ßàÞäØÛì "¿ÞÛÕâ". ·ÐâÕÜ ÜÞÖÝÞ ÒÚÛîçØâì âÕÛÕäÞÝ ÚÛÐÒØèÕÙ , 
ßÞáÛÕ çÕÓÞ ÚÞàÞâÚØÕ áÞÞÑéÕÝØï, äÐÚáØÜØÛìÝëÕ áÞÞÑéÕÝØï Ø ßÞçâÐ ÑãÔãâ 
ÞâßàÐÒÛÕÝë ÐÒâÞÜÐâØçÕáÚØ.

ºÞÓÔÐ ÚÞÜÜãÝØÚÐâÞà ÝÐåÞÔØâáï Ò àÕÖØÜÕ "¿ÞÛÕâ", áÛãÖÑã íÚáâàÕÝÝÞÙ ßÞÜÞéØ 
ÜÞÖÝÞ Òë×ÒÐâì âÞÛìÚÞ á ßÞÜÞéìî âÕÛÕäÞÝÐ (ßàØ ×ÐÚàëâÞÙ ÚàëèÚÕ 
ÚÞÜÜãÝØÚÐâÞàÐ) áÛÕÔãîéØÜ ÞÑàÐ×ÞÜ:

1 ½ÐÖÜØâÕ . ½Ð ÔØáßÛÕÕ âÕÛÕäÞÝÐ ßÞïÒØâáï áÞÞÑéÕÝØÕ Flight profile is 
active. (¿àÞäØÛì “¿ÞÛÕâ” ÐÚâØÒÕÝ).

2 ¿àØ ÒëÒÕÔÕÝÝÞÜ ÝÐ ÔØáßÛÕÙ áÞÞÑéÕÝØØ (Ò âÕçÕÝØÕ ßàØÜÕàÝÞ ßïâØ áÕÚãÝÔ) 
ÜÞÖÝÞ ÝÐÑàÐâì ÝÞÜÕà áÛãÖÑë íÚáâàÕÝÝÞÙ ßÞÜÞéØ, ×ÐßàÞÓàÐÜÜØàÞÒÐÝÝëÙ 
Ò ßÐÜïâØ ÚÞÜÜãÝØÚÐâÞàÐ, ÝÐßàØÜÕà, 112.

3 ½ÐÖÜØâÕ .

²°¶½¾µ ·°¼µÇ°½¸µ. ¸áßÞÛì×ÞÒÐÝØÕ âÕÛÕäÞÝÐ Ò ßÞÛÕâÕ ×ÐßàÕéÕÝÞ. 
²ëÚÛîçØâÕ âÕÛÕäÞÝ ßÕàÕÔ ßÞáÐÔÚÞÙ Ò áÐÜÞÛÕâ. 
¿ÞÛì×ÞÒÐÝØÕ ÑÕáßàÞÒÞÔÝëÜ âÕÛÕäÞÝÞÜ ÝÐ ÑÞàâã áÐÜÞÛÕâÐ 
ÜÞÖÕâ áÞ×ÔÐâì ßÞÜÕåØ Ò àÐÑÞâÕ áØáâÕÜ áÐÜÞÛÕâÐ, ÝÐàãèÐâì 
äãÝÚæØÞÝØàÞÒÐÝØÕ àÐÔØÞâÕÛÕäÞÝÝÞÙ áÕâØ Ø ßàÕáÛÕÔãÕâáï 
ßÞ ×ÐÚÞÝã. µáÛØ ßÕàáÞÝÐÛ áÐÜÞÛÕâÐ àÐ×àÕèÐÕâ 
ØáßÞÛì×ÞÒÐÝØÕ ØÝâÕàäÕÙáÐ ÚÞÜÜãÝØÚÐâÞàÐ, ½µ¾±Å¾´¸¼¾ 
ãáâÐÝÞÒØâì ßàÞäØÛì “¿ÞÛÕâ”. ÍâÞâ ßàÞäØÛì ßÞ×ÒÞÛïÕâ 
ØáßÞÛì×ÞÒÐâì ØÝâÕàäÕÙá ÚÞÜÜãÝØÚÐâÞàÐ Ø ÑÛÞÚØàãÕâ 
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ÞÒÚÛîçÕÝØÕ âÕÛÕäÞÝÐ. ¾ÑàÐâØâÕ ÒÝØÜÐÝØÕ ÝÐ âÞ, çâÞ ÒÞ ÒáÕå 

ÚÞÜÜãÝØÚÐæØÞÝÝëå ßàØÛÞÖÕÝØïå ØáßÞÛì×ãÕâáï ØÝâÕàäÕÙá 
âÕÛÕäÞÝÐ.

¿àØÛÞÖÕÝØï Messaging
³àãßßÐ Messaging áÞÔÕàÖØâ ßàØÛÞÖÕÝØï Fax (ÂÕÛÕäÐÚá), Mail (¿ÞçâÐ) Ø SMS 
(ºÞàÞâÚØÕ áÞÞÑéÕÝØï). ´Ûï ×ÐßãáÚÐ ßàØÛÞÖÕÝØï Messaging ÝÐÖÜØâÕ ÚÛÐÒØèã 
ßàØÛÞÖÕÝØï Messaging ÝÐ ÚÛÐÒØÐâãàÕ ÚÞÜÜãÝØÚÐâÞàÐ.

´Ûï ßÕàÕÔÐçØ Ø ßàØÕÜÐ äÐÚáÞÒ, íÛÕÚâàÞÝÝÞÙ ßÞçâë Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ 
ÔÞÛÖÝë Ñëâì ÒëßÞÛÝÕÝë áÛÕÔãîéØÕ ãáÛÞÒØï:

• âÕÛÕäÞÝ ÒÚÛîçÕÝ;
• ØáßÞÛì×ãÕÜÐï áÞâÞÒÐï áÕâì ßàÕÔÞáâÐÒÛïÕâ ãáÛãÓØ ßÕàÕÔÐçØ äÐÚáÞÒ, 

ÔÐÝÝëå Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ;
• ãáÛãÓØ ßÕàÕÔÐçØ äÐÚáÞÒ, ÔÐÝÝëå Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ ßÞÔÔÕàÖØÒÐîâáï 

SIM-ÚÐàâÞÙ;
• ßÞáâÐÒéØÚ ãáÛãÓ ̧ ÝâÕàÝÕâ ßàÕÔÞáâÐÒØÛ ÔÐÝÝëÕ ßãÝÚâÐ ÔÞáâãßÐ Ò ̧ ÝâÕàÝÕâ 

(IAP), Ð Ò ßÐÜïâì ÚÞÜÜãÝØÚÐâÞàÐ ÒÒÕÔÕÝë ßÐàÐÜÕâàë ÔÞáâãßÐ Ú ̧ ÝâÕàÝÕâ Ø 
ßÞçâÞÒÞÜã áÕàÒÕàã;

• ÝÞÜÕà æÕÝâàÐ ßÕàÕÔÐçØ ÚÞàÞâÚØå áÞÞÑéÕÝØÙ ÒÒÕÔÕÝ Ò ßàØÛÞÖÕÝØÕ SMS.

´ÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî ÜÞÖÝÞ ßÞÛãçØâì ã ßÞáâÐÒéØÚÐ ãáÛãÓ áÞâÞÒÞÙ 
áÕâØ.

¿àØÜÕçÐÝØÕ. ¿ÞçâÞÒÐï áØáâÕÜÐ ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210i Communicator 
áÞÒÜÕáâØÜÐ áÞ áâÐÝÔÐàâÐÜØ ¸ÝâÕàÝÕâ SMTP, IMAP4 Ø POP3.
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Þ ÁÞ×ÔÐÝØÕ Ø ßÕàÕÔÐçÐ äÐÚáÞÒ, íÛÕÚâàÞÝÝÞÙ 
ßÞçâë Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ
´Ûï áÞ×ÔÐÝØï, àÕÔÐÚâØàÞÒÐÝØï Ø ßÕàÕÔÐçØ äÐÚáÞÒ, áÞÞÑéÕÝØÙ íÛÕÚâàÞÝÝÞÙ 
ßÞçâë Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ ßàÕÔÝÐ×ÝÐçÕÝë áÞÞâÒÕâáâÒãîéØÕ àÕÔÐÚâÞàë, 
ÔÛï ×ÐßãáÚÐ ÚÞâÞàëå ßàÕÔãáÜÞâàÕÝÞ âàØ áßÞáÞÑÐ: 

• ²ÒÕÔØâÕ Ø ÞâäÞàÜÐâØàãÙâÕ âÕÚáâ Ò ÛîÑÞÜ Ø× ßàØÛÞÖÕÝØÙ ÚÞÜÜãÝØÚÐâÞàÐ, 
ÚÞâÞàÞÕ ßÞ×ÒÞÛïÕâ àÕÔÐÚâØàÞÒÐâì âÕÚáâ. ´Ûï ßÕàÕÔÐçØ âÕÚáâÐ ÝÐÖÜØâÕ 
ÚÛÐÒØèã Menu, ÒëÑÕàØâÕ File > Send, ×ÐâÕÜ ÒëÑÕàØâÕ Ò ßÞÔÜÕÝî ÞÔØÝ Ø× 
àÕÖØÜÞÒ ßÕàÕÔÐçØ.

• ² ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Messaging ÒëÑÕàØâÕ ÞÔÝã Ø× ÚÞÜÐÝÔ: Write 

fax (ÁÞ×ÔÐâì äÐÚá), Write mail (ÁÞ×ÔÐâì ßØáìÜÞ) ØÛØ Write short message 
(ÁÞ×ÔÐâì ÚÞàÞâÚÞÕ áÞÞÑéÕÝØÕ).

• ² ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Messaging ÝÐÖÜØâÕ ÚÛÐÒØèã Menu Ø 
ÒëÑÕàØâÕ Write > New message. ·ÐâÕÜ ÒëÑÕàØâÕ âàÕÑãÕÜëÙ âØß áÞÞÑéÕÝØï.

²ëÑÞà ÐÔàÕáÐâÞÒ

¿àØÜÕçÐÝØÕ. ÄÐÚá ØÛØ âÕÚáâÞÒÞÕ áÞÞÑéÕÝØÕ ÜÞÖÝÞ ÞâßàÐÒØâì âÞÛìÚÞ ßÞ 
ÞÔÝÞÜã ÐÔàÕáã.

¿àÕÔãáÜÞâàÕÝÞ ÔÒÐ áßÞáÞÑÐ ÒëÑÞàÐ ÐÔàÕáÐ ÝÐ×ÝÐçÕÝØï ÔÛï ßÕàÕÔÐçØ äÐÚáÐ, 
íÛÕÚâàÞÝÝÞÓÞ ßØáìÜÐ Ø ÚÞàÞâÚÞÓÞ áÞÞÑéÕÝØï:

1 ½ÐÖÜØâÕ Recipient (°ÔàÕáÐâ) Ò áÞÞâÒÕâáâÒãîéÕÜ àÕÔÐÚâÞàÕ áÞÞÑéÕÝØÙ. 
¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ áÞ áßØáÚÞÜ ÚÞÝâÐÚâÞÒ.

2 ½ÐÙÔØâÕ ÚÞÝâÐÚâ ØÛØ ÚÞÝâÐÚâë Ò ÛÕÒÞÜ ÞÚÝÕ Ø ÝÐÖÜØâÕ Select (²ëÑàÐâì).
3 ½ÐÖÜØâÕ Done (³ÞâÞÒÞ).
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Þ¼ÞÖÝÞ âÐÚÖÕ ÒÒÕáâØ ØÜï ÐÔàÕáÐâÐ Ò ×ÐÓÞÛÞÒÚÕ äÐÚáÐ, íÛÕÚâàÞÝÝÞÓÞ ßØáìÜÐ 

ØÛØ ÚÞàÞâÚÞÓÞ áÞÞÑéÕÝØï Ø áÒÕàØâì íâÞ ØÜï á ÑÐ×ÞÙ ÔÐÝÝëå ÚÞÝâÐÚâÞÒ.

¿àØÕÜ Ø çâÕÝØÕ äÐÚáÞÒ Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ
¿àØÕÜ äÐÚáÞÒ ÞáãéÕáâÒÛïÕâáï ÐÒâÞÜÐâØçÕáÚØ ßàØ ãáÛÞÒØØ, çâÞ âÐÚÐï ãáÛãÓÐ 
ÔÞáâãßÝÐ, Ð âÕÛÕäÞÝ ÒÚÛîçÕÝ Ø ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ áÕâØ. 
ºÞàÞâÚØÕ áÞÞÑéÕÝØï ßàØÝØÜÐîâáï ÐÒâÞÜÐâØçÕáÚØ, ÕáÛØ âÕÛÕäÞÝ ÒÚÛîçÕÝ.

¿àÕÔãáÜÞâàÕÝÞ ÔÒÐ áßÞáÞÑÐ çâÕÝØï ßàØÝïâëå äÐÚáÞÒ Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ:

• ¿àØ ßÞïÒÛÕÝØØ ÝÐ ÔØáßÛÕÕ áÞÞÑéÕÝØï (ØÛØ ßÞáÛÕ ×ÒãÚÞÒÞÓÞ áØÓÝÐÛÐ Þ 
ßàØÕÜÕ áÞÞÑéÕÝØï) ÝÐÖÜØâÕ Open (¾âÚàëâì). ·ÒãÚÞÒÞÙ áØÓÝÐÛ ßÞÔÐÕâáï 
âÞÛìÚÞ Ò ÞßàÕÔÕÛÕÝÝëå áÛãçÐïå.

• ¾âÚàÞÙâÕ ßàØÛÞÖÕÝØÕ Messaging. ²ëÑÕàØâÕ ßàØÝïâÞÕ áÞÞÑéÕÝØÕ Ò ßÐßÚÕ 
Inbox Ø ÝÐÖÜØâÕ Open. ÄÐÚá ØÛØ ÚÞàÞâÚÞÕ áÞÞÑéÕÝØÕ ÑãÔÕâ ÞâÚàëâÞ Ò 
áÞÞâÒÕâáâÒãîéÕÜ ßàØÛÞÖÕÝØØ.

¿àØÕÜ Ø çâÕÝØÕ íÛÕÚâàÞÝÝÞÙ ßÞçâë
²åÞÔïéÐï ßÞçâÐ ÝÕ ßÞáâãßÐÕâ Ò ÚÞÜÜãÝØÚÐâÞà ÐÒâÞÜÐâØçÕáÚØ, Ð åàÐÝØâáï Ò 
ãÔÐÛÕÝÝÞÜ ßÞçâÞÒÞÜ ïéØÚÕ. ´Ûï çâÕÝØï ßÞçâë ÝÕÞÑåÞÔØÜÞ áÝÐçÐÛÐ 
ãáâÐÝÞÒØâì áÞÕÔØÝÕÝØÕ á ãÔÐÛÕÝÝëÜ ßÞçâÞÒëÜ ïéØÚÞÜ Ø ÒëÑàÐâì 
áÞÞÑéÕÝØï, ÚÞâÞàëÕ âàÕÑãÕâáï ×ÐÓàã×Øâì Ò ÚÞÜÜãÝØÚÐâÞà. ÁÞÕÔØÝÕÝØÕ á 
ãÔÐÛÕÝÝëÜ ßÞçâÞÒëÜ ïéØÚÞÜ ÞáãéÕáâÒÛïÕâáï ßÞáàÕÔáâÒÞÜ Òë×ÞÒÐ Ò àÕÖØÜÕ 
ßÕàÕÔÐçØ ÔÐÝÝëå.

ÁÞÕÔØÝÕÝØÕ á ãÔÐÛÕÝÝëÜ ßÞçâÞÒëÜ ïéØÚÞÜ

1 ²ëÑÕàØâÕ ãÔÐÛÕÝÝëÙ ßÞçâÞÒëÙ ïéØÚ Ò ÛÕÒÞÜ ÞÚÝÕ ÓÛÐÒÝÞÓÞ íÚàÐÝÐ 
ßàØÛÞÖÕÝØï Messaging.
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Þ 2 ½ÐÖÜØâÕ Retrieve mail (·ÐÓàã×Øâì ßÞçâã). 
3 ¿ÞáÛÕ ãáâÐÝÞÒÛÕÝØï áÞÕÔØÝÕÝØï á ãÔÐÛÕÝÝëÜ ßÞçâÞÒëÜ ïéØÚÞÜ ÝÐÖÜØâÕ 

ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ Retrieve > New (½ÞÒëÕ), Selected (²ëÑàÐÝÝëÕ) 
ØÛØ All (²áÕ áÞÞÑéÕÝØï íÛÕÚâàÞÝÝÞÙ ßÞçâë).

4 ¿ÞáÛÕ ×ÐÒÕàèÕÝØï ×ÐÓàã×ÚØ ÒáÕå ×ÐßàÞèÕÝÝëå áÞÞÑéÕÝØÙ íÛÕÚâàÞÝÝÞÙ 
ßÞçâë ÝÐÖÜØâÕ Go offline (ÀÐ×ÞàÒÐâì áÞÕÔØÝÕÝØÕ).

5 ²ëÑÕàØâÕ áÞÞÑéÕÝØÕ íÛÕÚâàÞÝÝÞÙ ßÞçâë, ÚÞâÞàÞÕ âàÕÑãÕâáï ßàÞçØâÐâì, Ø 
ÝÐÖÜØâÕ Open (¾âÚàëâì).

¿àØÜÕçÐÝØÕ. ¿ÐàÐÜÕâàë ãçÕâÝÞÙ ×ÐßØáØ ãÔÐÛÕÝÝÞÓÞ ßÞçâÞÒÞÓÞ ïéØÚÐ 
ÜÞÖÝÞ ãáâÐÝÞÒØâì âÐÚØÜ ÞÑàÐ×ÞÜ, çâÞÑë ×ÐÓàãÖÐâì Ò 
ÚÞÜÜãÝØÚÐâÞà âÞÛìÚÞ ×ÐÓÞÛÞÒÚØ áÞÞÑéÕÝØÙ. ² íâÞÜ áÛãçÐÕ 
ßàØ ÝÐÖÐâØØ ÚÛÐÒØèØ Open (¾âÚàëâì) ßÞáÛÕ ×ÐÓàã×ÚØ ßÞçâë 
ÝÐ ÔØáßÛÕÙ ÒëÒÞÔØâáï ×ÐßàÞá ÝÐ ×ÐÓàã×Úã ÞáâÐÒèÕÙáï çÐáâØ 
ÒëÑàÐÝÝÞÓÞ áÞÞÑéÕÝØï.

¿Àµ´Ã¿Àµ´µ½¸µ! ÁÞÞÑéÕÝØï, ÞâÜÕçÕÝÝëÕ ÚÐÚ ãÔÐÛÕÝÝëÕ ßàØ àÐÑÞâÕ 

Ò ÐÒâÞÝÞÜÝÞÜ àÕÖØÜÕ, ßÞáÛÕ ãáâÐÝÞÒÚØ 

áÞÕÔØÝÕÝØï ÑãÔãâ âÐÚÖÕ ãÔÐÛÕÝë Ø× 

àÐáßÞÛÞÖÕÝÝÞÓÞ ÝÐ ãÔÐÛÕÝÝÞÜ áÕàÒÕàÕ 

ßÞçâÞÒÞÓÞ ïéØÚÐ.  

¿àØÛÞÖÕÝØÕ Internet
´Ûï ßÞÛãçÕÝØï ÔÞáâãßÐ Ú áÕâØ ̧ ÝâÕàÝÕâ ÔÞÛÖÝë Ñëâì ÒëßÞÛÝÕÝë áÛÕÔãîéØÕ 
ãáÛÞÒØï:

• áÞâÞÒÐï áÕâì ßàÕÔÞáâÐÒÛïÕâ ãáÛãÓã ßÕàÕÔÐçØ ÔÐÝÝëå;
• ãáÛãÓÐ ßÕàÕÔÐçØ ÔÐÝÝëå ßÞÔÔÕàÖØÒÐÕâáï SIM-ÚÐàâÞÙ;
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Þ• ßÞáâÐÒéØÚ ãáÛãÓ ̧ ÝâÕàÝÕâ ßàÕÔÞáâÐÒØÛ ÔÐÝÝëÕ ßãÝÚâÐ ÔÞáâãßÐ Ò ̧ ÝâÕàÝÕâ 

(IAP) Ø
• Ò ßÐÜïâì ÚÞÜÜãÝØÚÐâÞàÐ ÒÒÕÔÕÝë ßÐàÐÜÕâàë ÔÞáâãßÐ Ú ¸ÝâÕàÝÕâ. 

²ëßÞÛÝØâÕ ØÝáâàãÚæØØ, ßàØÒÕÔÕÝÝëÕ Ò àãÚÞÒÞÔáâÒÕ ßÞ íÚáßÛãÐâÐæØØ. 
·ÐßØèØâÕ ×ÝÐçÕÝØï ßÐàÐÜÕâàÞÒ Ò ÃáâÐÝÞÒÞçÝëÙ ßÕàÕçÕÝì (Settings 
checklist), ßàØÛÐÓÐÕÜëÙ Ú ÚÞÜÜãÝØÚÐâÞàã.

¸ÝáâàãÚæØØ ßÞ ãáâÐÝÞÒÚÕ ßÐàÐÜÕâàÞÒ ÔÛï àÐÑÞâë Ò áÕâØ ¸ÝâÕàÝÕâ ÜÞÖÝÞ 
ßÞÛãçØâì ã ßÞáâÐÒéØÚÐ ãáÛãÓ ¸ÝâÕàÝÕâ. ÁâàÞÓÞ áÛÕÔãÙâÕ ßÞÛãçÕÝÝëÜ 
ØÝáâàãÚæØïÜ.

¿àØÜÕçÐÝØÕ. ´Ûï ßÞÔÚÛîçÕÝØï Ú áÕâØ ¸ÝâÕàÝÕâ ÝÕÞÑåÞÔØÜÞ áÛÕÔãîéÕÕ: 
âÕÛÕäÞÝ ÒÚÛîçÕÝ Ø ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ 
áÕâØ, ÞâáãâáâÒãîâ ÐÚâØÒÝëÕ ÓÞÛÞáÞÒëÕ Òë×ÞÒë ØÛØ Òë×ÞÒë Ò 
àÕÖØÜÕ ßÕàÕÔÐçØ ÔÐÝÝëå.

ÃáâÐÝÞÒÛÕÝØÕ áÞÕÔØÝÕÝØï á ¸ÝâÕàÝÕâ

1 ½ÐÖÜØâÕ ÚÛÐÒØèã ßàØÛÞÖÕÝØï Internet ÝÐ ÚÛÐÒØÐâãàÕ ÚÞÜÜãÝØÚÐâÞàÐ.
2 ²ëÑÕàØâÕ âàÕÑãÕÜÞÕ ßàØÛÞÖÕÝØÕ (ÝÐßàØÜÕà, WWW) Ø ÝÐÖÜØâÕ Open 

(¾âÚàëâì). ºÞÓÔÐ ßàØÛÞÖÕÝØî ßÞâàÕÑãÕâáï ãáâÐÝÞÒØâì áÞÕÔØÝÕÝØÕ, 
ÞâÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ, Ò ÚÞâÞàÞÜ ÒëÒÕÔÕÝë ßÞÛï Connection name 
(½Ð×ÒÐÝØÕ áÞÕÔØÝÕÝØï) Ø Phone number (ÂÕÛÕäÞÝÝëÙ ÝÞÜÕà) ßãÝÚâÐ ÔÞáâãßÐ 
IAP, ØáßÞÛì×ãÕÜÞÓÞ ÔÛï ãáâÐÝÞÒÛÕÝØï áÞÕÔØÝÕÝØï. 

3 ´Ûï ãáâÐÝÞÒÛÕÝØï áÞÕÔØÝÕÝØï ÝÐÖÜØâÕ OK.
4 ½ÐÖÜØâÕ Done (³ÞâÞÒÞ), çâÞÑë ×ÐÚàëâì ßàØÛÞÖÕÝØÕ.
5 ´Ûï ÞâÚÛîçÕÝØï Þâ áÕâØ ¸ÝâÕàÝÕâ ÝÐÖÜØâÕ ÚÛÐÒØèã ßàØÛÞÖÕÝØï Internet 

Ò ÛîÑÞÜ Ø× ßàØÛÞÖÕÝØÙ ¸ÝâÕàÝÕâ, ×ÐâÕÜ ÝÐÖÜØâÕ Disconnect 
(ÀÐ×êÕÔØÝØâì). ÀÐ×êÕÔØÝÕÝØÕ ÒëßÞÛÝïÕâáï ÝÕÜÕÔÛÕÝÝÞ.
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Þ ±àÐã×Õà WWW
¿àØÜÕà. ¿àØÜÕà ÐÔàÕáÐ 
URL: www.nokia.com.

WWW — íâÞâ ÓØßÕàâÕÚáâÞÒÐï áØáâÕÜÐ, ßàÕÔÝÐ×ÝÐçÕÝÝÐï ÔÛï ßÞØáÚÐ Ø ÔÞáâãßÐ 
Ú àÕáãàáÐÜ ¸ÝâÕàÝÕâ. ´Ûï ßàÞáÜÞâàÐ áÕâØ ¸ÝâÕàÝÕâ:

ÁÞÒÕâ. ´Ûï ×ÐÓàã×ÚØ 
ÝÕÚÞâÞàëå áâàÐÝØæ WWW 
âàÕÑãÕâáï ãÚÐ×Ðâì ØÜï 
ßÞÛì×ÞÒÐâÕÛï Ø ßÐàÞÛì.

1 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ File > Open > Web page.
2 ²ÒÕÔØâÕ ÐÔàÕá URL Ò ßÞÛÕ ÐÔàÕáÐ ØÛØ ÒëÑÕàØâÕ ×ÐÚÛÐÔÚã Ø× áßØáÚÐ 

×ÐÚÛÐÔÞÚ, ×ÐâÕÜ ÝÐÖÜØâÕ Go to (¿ÕàÕÙâØ). ¼ÞÖÝÞ âÐÚÖÕ ßÕàÕåÞÔØâì ÝÐ 
ÔàãÓØÕ web-áâàÐÝØæë á ÝÐçÐÛìÝÞÙ áâàÐÝØæë ÑàÐã×ÕàÐ WWW.

3 ¿ÞáÛÕ âÞÓÞ, ÚÐÚ áâàÐÝØæÐ ×ÐÓàãÖÕÝÐ Ø ÞâÚàëâÐ, ÔÛï ÒëÑÞàÐ ááëÛÞÚ Ø 
ÐÚâØÒÝëå ÞÑÛÐáâÕÙ ØáßÞÛì×ãÕâáï ÚÛÐÒØèÐ Tab. ´Ûï ßÕàÕåÞÔÐ ÝÐ×ÐÔ 
ÝÐÖÜØâÕ Shift+Tab. ¼ÞÖÝÞ âÐÚÖÕ ÒÞáßÞÛì×ÞÒÐâìáï ØÝáâàãÜÕÝâÞÜ Pointer 
(ÃÚÐ×ÐâÕÛì). ´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï ßÞ ØÝáâàãÜÕÝâã Pointer 
ßàØÒÕÔÕÝÐ Ò àãÚÞÒÞÔáâÒÕ ßÞ íÚáßÛãÐâÐæØØ.

4 ¿ÕàÕÙÔØâÕ ÝÐ ÔàãÓãî áâàÐÝØæã ØÛØ web-ã×ÕÛ, ÒëÑÕàØâÕ ÓØßÕàááëÛÚã ØÛØ 
ÐÚâØÒÝãî ÞÑÛÐáâì Ø ÝÐÖÜØâÕ Go to.

¿àØÛÞÖÕÝØÕ WAP
¿àØÛÞÖÕÝØÕ WAP — íâÞ ÓØßÕàâÕÚáâÞÒÐï áØáâÕÜÐ, ßàÕÔÝÐ×ÝÐçÕÝÝÐï ÔÛï 
ÔÞáâãßÐ Ú ãáÛãÓÐÜ ¸ÝâÕàÝÕâ, áÞÔÕàÖÐéØÜ ÝÞÒÞáâØ, ßàÞÓÝÞ×ë ßÞÓÞÔë, 
àÐáßØáÐÝØï ÔÒØÖÕÝØï âàÐÝáßÞàâÐ, áÛÞÒÐàØ Ø ßà. ÍâÞ áØáâÕÜÐ ÞàØÕÝâØàÞÒÐÝÐ 
ÝÐ ßÞÛì×ÞÒÐâÕÛÕÙ ÜÞÑØÛìÝëå áàÕÔáâÒ áÒï×Ø.

´Ûï ßÞÛãçÕÝØï ÔÞáâãßÐ Ú ãáÛãÓÐÜ WAP ÝÕÞÑåÞÔØÜÞ ÒëßÞÛÝÕÝØÕ áÛÕÔãîéØå 
ãáÛÞÒØÙ: 

• âÕÛÕäÞÝ ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ áÕâØ, ßàÕÔÞáâÐÒÛïîéÕÙ 
ãáÛãÓã ßÕàÕÔÐçØ ÔÐÝÝëå;

• ãáÛãÓÐ ßÕàÕÔÐçØ ÔÐÝÝëå ßÞÔÔÕàÖØÒÐÕâáï SIM-ÚÐàâÞÙ;
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Þ• ßÞáâÐÒéØÚ ãáÛãÓ WAP ßàÕÔÞáâÐÒØÛ ÔÐÝÝëÕ ßãÝÚâÐ ÔÞáâãßÐ Ú ãáÛãÓÐÜ WAP 

Ø
• Ò ßÐÜïâì ÚÞÜÜãÝØÚÐâÞàÐ ÒÒÕÔÕÝë ßÐàÐÜÕâàë ÔÞáâãßÐ Ú ãáÛãÓÐÜ WAP. 

²ëßÞÛÝØâÕ ØÝáâàãÚæØØ, ßàØÒÕÔÕÝÝëÕ Ò àãÚÞÒÞÔáâÒÕ ßÞ íÚáßÛãÐâÐæØØ.

´Þáâãß Ú ãáÛãÓÐÜ WAP

´Ûï âÞÓÞ, çâÞÑë ÞâÚàëâì áâàÐÝØæã WAP:

1 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ File > Open page. ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ 
ÞÚÝÞ. ²ÒÕÔØâÕ ÐÔàÕá URL, ÝÐßàØÜÕà, mobile.club.nokia.com.

2 Á ßÞÜÞéìî ÚÛÐÒØèØ áÞ áâàÕÛÚÐÜØ ÜÞÖÝÞ ßàÞÚàãâØâì áâàÐÝØæã ÔÛï 
ÒëÑÞàÐ ÓØßÕàááëÛÞÚ Ø ÐÚâØÒÝëå ÞÑÛÐáâÕÙ.

¿àØÜÕçÐÝØÕ. ́ Ûï ÔÞáâãßÐ Ú ÝÕÚÞâÞàëÜ áÕàÒÕàÐÜ, ÝÐ ÚÞâÞàëå ãáâÐÝÞÒÛÕÝÐ 
áØáâÕÜÐ ãßàÐÒÛÕÝØï ÔÞáâãßÞÜ, âàÕÑãÕâáï ÒÒÕáâØ ØÜï 
ßÞÛì×ÞÒÐâÕÛï Ø ßÐàÞÛì. ² íâÞÜ áÛãçÐÕ ßÕàÕÔ ãáâÐÝÞÒÛÕÝØÕÜ 
áÞÕÔØÝÕÝØï á ãáÛãÓÞÙ ÝÐ ÔØáßÛÕÕ ßÞïÒØâáï ×ÐßàÞá ØÜÕÝØ 
ßÞÛì×ÞÒÐâÕÛï Ø ßÐàÞÛï.

¿àØÛÞÖÕÝØÕ Contacts
´Ûï ×ÐßãáÚÐ ßàØÛÞÖÕÝØï Contacts (ºÞÝâÐÚâë) ÝÐÖÜØâÕ ÚÛÐÒØèã ßàØÛÞÖÕÝØï 
Contacts ÝÐ ÚÛÐÒØÐâãàÕ ÚÞÜÜãÝØÚÐâÞàÐ. ¿àØÛÞÖÕÝØÕ Contacts ßàÕÔÝÐ×ÝÐçÕÝÞ 
ÔÛï áÞ×ÔÐÝØï, àÕÔÐÚâØàÞÒÐÝØï Ø ÞàÓÐÝØ×ÐæØØ ßÕàáÞÝÐÛìÝÞÙ ØÝäÞàÜÐæØØ, 
âÐÚÞÙ ÚÐÚ âÕÛÕäÞÝÝëÕ ÝÞÜÕàÐ Ø ÐÔàÕáÐ. ÍÛÕÜÕÝâë ÚÐâÐÛÞÓÐ Contacts 
ÝÐ×ëÒÐîâáï ÒØ×ØâÝëÜØ ÚÐàâÞçÚÐÜØ. ¸ÝäÞàÜÐæØî Þ ÚÞÝâÐÚâÐå ÜÞÖÝÞ 
áØÝåàÞÝØ×ØàÞÒÐâì á áÞÒÜÕáâØÜëÜ ßÕàáÞÝÐÛìÝëÜ ÚÞÜßìîâÕàÞÜ. 
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Þ ´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï Þ áØÝåàÞÝØ×ÐæØØ ÚÞÝâÐÚâÞÒ ßàØÒÕÔÕÝÐ Ò 
àãÚÞÒÞÔáâÒÕ ßÞÛì×ÞÒÐâÕÛï ßàÞÓàÐÜÜÝÞÓÞ ÞÑÕáßÕçÕÝØï PC Suite, ÚÞâÞàÞÕ 
ÝÐåÞÔØâáï ÝÐ ßàØÛÐÓÐÕÜÞÜ Ú ÚÞÜÜãÝØÚÐâÞàã ÚÞÜßÐÚâ-ÔØáÚÕ.

³ÛÐÒÝÐï ÑÐ×Ð ÔÐÝÝëå ÚÞÝâÐÚâÞÒ ÝÐåÞÔØâáï Ò ßÐÜïâØ ÚÞÜÜãÝØÚÐâÞàÐ. ºÞÝâÐÚâë 
ÜÞÖÝÞ âÐÚÖÕ áÞåàÐÝïâì Ò ÞâÔÕÛìÝëå ÑÐ×Ðå ÔÐÝÝëå ÝÐ ßÞÔÚÛîçÕÝÝÞÙ ÚÐàâÕ 
ßÐÜïâØ.

ÁÞ×ÔÐÝØÕ ÒØ×ØâÝÞÙ ÚÐàâÞçÚØ
1 ² ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Contacts ÝÐÖÜØâÕ New card (½ÞÒÐï 

ÚÐàâÞçÚÐ).
2 ² ßÞïÒØÒèÕÜáï ÝÐ ÔØáßÛÕÕ ÑÛÐÝÚÕ ÒØ×ØâÝÞÙ ÚÐàâÞçÚØ ÒÒÕÔØâÕ 

ÝÕÞÑåÞÔØÜëÕ ÔÐÝÝëÕ Ò áÞÞâÒÕâáâÒãîéØÕ ßÞÛï.
3 ´Ûï áÞåàÐÝÕÝØï ÒØ×ØâÝÞÙ ÚÐàâÞçÚØ ÝÐÖÜØâÕ Done (³ÞâÞÒÞ).

²ë×ÞÒ ÚÞÝâÐÚâÐ
³ÛÐÒÝëÙ íÚàÐÝ ßàØÛÞÖÕÝØï Contacts àÐ×ÔÕÛÕÝ ÝÐ ÔÒÐ ÞÚÝÐ — ÛÕÒÞÕ Ø ßàÐÒÞÕ. 
´Ûï ßÕàÕåÞÔÐ Ò ßàÐÒÞÕ ÞÚÝÞ ÝÐÖÜØâÕ ÚÛÐÒØèã Tab. ²ëÔÕÛØâÕ âÕÛÕäÞÝÝëÙ 
ÝÞÜÕà ÚÞÝâÐÚâÐ Ø ÝÐÖÜØâÕ Call (²ë×ÞÒ).
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Þ¿àØÛÞÖÕÝØÕ Calendar

¿àØÛÞÖÕÝØÕ Calendar (ºÐÛÕÝÔÐàì) ßÞ×ÒÞÛïÕâ áÛÕÔØâì ×Ð ×ÐßÛÐÝØàÞÒÐÝÝëÜØ 
áÞÑëâØïÜØ, ÜÕàÞßàØïâØïÜØ, îÑØÛÕÙÝëÜØ ÔÐâÐÜØ, ÔÝïÜØ àÞÖÔÕÝØï Ø ßà. ́ Ûï 
ÛîÑÞÙ ×ÐßØáØ ÚÐÛÕÝÔÐàï ÜÞÖÝÞ ãáâÐÝÞÒØâì ×ÒãÚÞÒãî áØÓÝÐÛØ×ÐæØî. ´Ûï 
×ÐßãáÚÐ ßàØÛÞÖÕÝØï Calendar (ºÐÛÕÝÔÐàì) ÝÐÖÜØâÕ ÚÛÐÒØèã ßàØÛÞÖÕÝØï 
Calendar ÝÐ ÚÛÐÒØÐâãàÕ ÚÞÜÜãÝØÚÐâÞàÐ.

¿àØ ßÞÔÚÛîçÕÝØØ ÚÞÜÜãÝØÚÐâÞàÐ Ú áÞÒÜÕáâØÜÞÜã ¿º ÒÞ×ÜÞÖÝÐ 
áØÝåàÞÝØ×ÐæØï ÚÐÛÕÝÔÐàï Ø ×ÐÔÐÝØÙ á ßàÞÓàÐÜÜÐÜØ Microsoft Windows Ø 
Lotus. ´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï Þ áØÝåàÞÝØ×ÐæØØ ßàØÒÕÔÕÝÐ Ò 
àãÚÞÒÞÔáâÒÕ ßÞÛì×ÞÒÐâÕÛï ßàÞÓàÐÜÜÝÞÓÞ ÞÑÕáßÕçÕÝØï PC Suite, ÚÞâÞàÞÕ 
ÝÐåÞÔØâáï ÝÐ ßàØÛÐÓÐÕÜÞÜ Ú ÚÞÜÜãÝØÚÐâÞàã ÚÞÜßÐÚâ-ÔØáÚÕ.

ÁÞ×ÔÐÝØÕ ÝÞÒÞÙ ×ÐßØáØ ÚÐÛÕÝÔÐàï
ÁÐÜëÙ ßàÞáâÞÙ áßÞáÞÑ áÞ×ÔÐÝØï ×ÐßØáØ ÚÐÛÕÝÔÐàï:

1 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ File > New entry. ²ëÑÕàØâÕ âØß ÝÞÒÞÙ 
×ÐßØáØ: Appointment (²áâàÕçÐ), Event (ÁÞÑëâØÕ), Anniversary (³ÞÔÞÒéØÝÐ) ØÛØ 
Task (·ÐÔÐÝØÕ).

2 ²ÒÕÔØâÕ ÝÕÞÑåÞÔØÜãî ØÝäÞàÜÐæØî Ò ßÞÛï ÝÐ áâàÐÝØæÐå ÔØÐÛÞÓÞÒÞÓÞ 
ÞÚÝÐ.

¾Ñ×Þà ÜÕáïæÐ
¾Ñ×Þà ÜÕáïæÐ — íâÞ ÓÛÐÒÝëÙ íÚàÐÝ ßàØÛÞÖÕÝØï Calendar. µáÛØ ÔÛï ÚÐÚÞÓÞ-
ÛØÑÞ ÜÕáïæÐ Ò ÚÐÛÕÝÔÐàÕ ÒÒÕÔÕÝÐ ØÝäÞàÜÐæØï, á ßàÐÒÞÙ áâÞàÞÝë íÚàÐÝÐ 
ÒëÒÞÔØâáï áßØáÞÚ áÞÑëâØÙ. ´Ûï Ø×ÜÕÝÕÝØï áÞÑëâØï:
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Þ 1 ²ëÔÕÛØâÕ ßàÐÒÞÕ ÞÚÝÞ, ÝÐÖÐÒ ÚÛÐÒØèã Enter ØÛØ Edit day (¸×ÜÕÝØâì ÔÕÝì).
2 ²ëÑÕàØâÕ áÞÑëâØÕ Ø ÝÐÖÜØâÕ Edit (¸×ÜÕÝØâì). ½Ð ÔØáßÛÕÕ ßÞïÒØâáï ÞÚÝÞ 

ÔÐÝÝëå áÞÑëâØï.
3 ¸×ÜÕÝØâÕ ÔÐÝÝëÕ áÞÑëâØï, ÚÐÚ ÝÕÞÑåÞÔØÜÞ.

¾Ñ×Þà ÝÕÔÕÛØ
¾Ñ×Þà ÝÕÔÕÛØ áÞÔÕàÖØâ áÞÑëâØï, ×ÐßÛÐÝØàÞÒÐÝÝëÕ ÝÐ ÒëÑàÐÝÝãî ÝÕÔÕÛî. 
´Ûï ßÕàÕåÞÔÐ Ò àÕÖØÜ ÞÑ×ÞàÐ ÝÕÔÕÛØ ÝÐÖÜØâÕ Change view (¸×ÜÕÝØâì ÒØÔ) Ø 
ÒëÑÕàØâÕ Week (½ÕÔÕÛï).

¾Ñ×Þà ÔÝï
² àÕÖØÜÕ ÞÑ×ÞàÐ ÔÝï ÞâÞÑàÐÖÐîâáï áÞÑëâØï, ×ÐßÛÐÝØàÞÒÐÝÝëÕ ÝÐ 
ÒëÑàÐÝÝëÙ ÔÕÝì. ´Ûï ßÕàÕåÞÔÐ Ò àÕÖØÜ ÞÑ×ÞàÐ ÔÝï ÝÐÖÜØâÕ Change view Ø 
ÒëÑÕàØâÕ Day (´ÕÝì). 

¾Ñ×Þà ×ÐÔÐÝØÙ
² àÕÖØÜÕ ÞÑ×ÞàÐ ×ÐÔÐÝØÙ ÞâÞÑàÐÖÐÕâáï ÞÔØÝ áßØáÞÚ ×ÐÔÐÝØÙ. ÀÕÖØÜ ÞÑ×ÞàÐ 
×ÐÔÐÝØÙ ßÞ×ÒÞÛïÕâ ßàÞáÜÞâàÕâì Ø ÞàÓÐÝØ×ÞÒÐâì ×ÐÔÐÝØï. ½ÐßàØÜÕà, ÜÞÖÝÞ 
ãáâÐÝÞÒØâì ÔÐâã ×ÐÒÕàèÕÝØï Ø ßàØÞàØâÕâ ×ÐÔÐÝØï. ¼ÞÖÝÞ âÐÚÖÕ áÞ×ÔÐâì 
ÝÕáÚÞÛìÚÞ áßØáÚÞÒ ×ÐÔÐÝØÙ, ÝÐßàØÜÕà, ÔÛï ÔÕÛÞÒëå Ø ÛØçÝëå ÜÕàÞßàØïâØÙ. 

´àãÓØÕ àÕÖØÜë ÞÑ×ÞàÐ
² ÚÞÜÜãÝØÚÐâÞàÕ ßàÕÔãáÜÞâàÕÝë Ø ÔàãÓØÕ àÕÖØÜë ÞÑ×ÞàÐ, âÐÚØÕ ÚÐÚ 
ÕÖÕÓÞÔÝØÚ Ø áßØáÞÚ îÑØÛÕÕÒ.
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Þ³àãßßÐ ßàØÛÞÖÕÝØÙ Office

³àãßßÐ ßàØÛÞÖÕÝØÙ Office (¾äØá) áÞÔÕàÖØâ ßàØÛÞÖÕÝØï Word Processor, Sheet, 
Presentation viewer Ø File manager (ÒáÕ ÞÝØ áÞÒÜÕáâØÜë á Microsoft Windows).

ÁÞ×ÔÐÝØÕ ÔÞÚãÜÕÝâÐ Word Processor
¿àØ ×ÐßãáÚÕ ßàØÛÞÖÕÝØï Word Processor (âÕÚáâÞÒëÙ àÕÔÐÚâÞà) ÞâÚàëÒÐÕâáï 
ÝÞÒëÙ ÔÞÚãÜÕÝâ. ÁàÐ×ã ÖÕ ßÞáÛÕ íâÞÓÞ ÜÞÖÝÞ ÝÐçÐâì ÒÒÞÔ âÕÚáâÐ.

´Ûï áÞåàÐÝÕÝØï ÔÞÚãÜÕÝâÐ ÝÐÖÜØâÕ Close (·ÐÚàëâì). ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ 
ÞÚÝÞ. ² íâÞÜ ÞÚÝÕ ÝÕÞÑåÞÔØÜÞ ÒÒÕáâØ ØÜï ÔÞÚãÜÕÝâÐ Ø ÒëÑàÐâì ßÐßÚã ÔÛï 
áÞåàÐÝÕÝØï ÔÞÚãÜÕÝâÐ.

¿àØÛÞÖÕÝØÕ Sheet
¿àØ àÐÑÞâÕ Ò ßàØÛÞÖÕÝØØ Sheet (ÂÐÑÛØæÐ) ÔÐÝÝëÕ åàÐÝïâáï Ò äÐÙÛÐå, 
ÝÐ×ëÒÐÕÜëå àÐÑÞçØÜØ ÚÝØÓÐÜØ. ºÐÖÔÐï àÐÑÞçÐï ÚÝØÓÐ áÞÔÕàÖØâ ÝÕ ÜÕÝÕÕ 
ÞÔÝÞÙ âÐÑÛØæë. ÀÐÑÞçÐï ÚÝØÓÐ ÜÞÖÕâ âÐÚÖÕ áÞÔÕàÖÐâì ÔØÐÓàÐÜÜë; 
ÔØÐÓàÐÜÜÐ — íâÞ âÐÑÛØçÝëÙ ÔÞÚãÜÕÝâ, Ò ÚÞâÞàÞÜ ÔÐÝÝëÕ âÐÑÛØæë 
ßàÕÔáâÐÒÛÕÝë Ò ÓàÐäØçÕáÚÞÜ äÞàÜÐâÕ.

ÁÞ×ÔÐÝØÕ àÐÑÞçÕÙ ÚÝØÓØ Ø âÐÑÛØæ

ÁÞÒÕâ. ´Ûï áÞ×ÔÐÝØï 
âÐÑÛØæë Ò ßàØÛÞÖÕÝØØ 
Desk ÝÐÖÜØâÕ ÚÛÐÒØèã 
Menu Ø ÒëÑÕàØâÕ File > Add 
to Desk.

´Ûï áÞ×ÔÐÝØï ÝÞÒÞÙ àÐÑÞçÕÙ ÚÝØÓØ ÝÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ File > 
New workbook.

´Ûï áÞåàÐÝÕÝØï àÐÑÞçÕÙ ÚÝØÓØ ÝÐÖÜØâÕ ÚÛÐÒØèã Menu ÝÐ íÚàÐÝÕ âÐÑÛØæë Ø 
ÒëÑÕàØâÕ File > Save.
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Þ ´Ûï áÞ×ÔÐÝØï ÝÞÒÞÙ âÐÑÛØæë Ò àÐÑÞçÕÙ ÚÝØÓÕ ÝÐÖÜØâÕ ÚÛÐÒØèã Menu Ø 
ÒëÑÕàØâÕ Insert > New worksheet.

´Ûï âÞÓÞ, çâÞÑë ÒÒÕáâØ ÔÐÝÝëÕ, ÒëÑÕàØâÕ ïçÕÙÚã á ßÞÜÞéìî ÚÛÐÒØè áÞ 
áâàÕÛÚÐÜØ Ø ÒÒÕÔØâÕ âàÕÑãÕÜãî ØÝäÞàÜÐæØî Ò ÒëÑàÐÝÝãî ïçÕÙÚã.

´Ûï ßÞÔâÒÕàÖÔÕÝØï ÒÒÞÔÐ ÔÐÝÝëå Ò ïçÕÙÚã ÝÐÖÜØâÕ ÚÛÐÒØèã Enter, OK ØÛØ 
ßÕàÕÙÔØâÕ Ò ÔàãÓãî ïçÕÙÚã á ßÞÜÞéìî ÚÛÐÒØèØ áÞ áâàÕÛÚÐÜØ. ´Ûï ÞâÜÕÝë 
ÞßÕàÐæØØ ÝÐÖÜØâÕ ÚÛÐÒØèã Esc ØÛØ Cancel (¾âÜÕÝØâì).

´Ûï ÞßàÕÔÕÛÕÝØï ÚÐâÕÓÞàØØ ÔÛï ÔÐÝÝëå Ò ïçÕÙÚÕ ÝÐÖÜØâÕ Function 
(ÄãÝÚæØï). ¿àÕÔãáÜÞâàÕÝë áÛÕÔãîéØÕ ÚÐâÕÓÞàØØ: All (²áÕ), Financial 
(ÄØÝÐÝáÞÒëÕ ÔÐÝÝëÕ), Date and time (´ÐâÐ Ø ÒàÕÜï), Mathematical 
(¼ÐâÕÜÐâØçÕáÚØÕ ÔÐÝÝëÕ), Statistical (ÁâÐâØáâØçÕáÚØÕ ÔÐÝÝëÕ), Lookup (¿ÞØáÚ), 
Text (ÂÕÚáâ), Logical (»ÞÓØçÕáÚØÕ ÔÐÝÝëÕ) Ø Information (¸ÝäÞàÜÐæØï). ºÐÖÔÞÙ 
ÚÐâÕÓÞàØØ áÞÞâÒÕâáâÒãÕâ ÝÐÑÞà äãÝÚæØÙ, ÚÞâÞàëÙ ÞâÞÑàÐÖÐÕâáï Ò áßØáÚÕ 
àïÔÞÜ á ßÞÛÕÜ Function name (¸Üï äãÝÚæØØ).

ÁÞ×ÔÐÝØÕ ÔØÐÓàÐÜÜ

¿àÕÔãáÜÞâàÕÝÞ áÕÜì àÐ×ÛØçÝëå âØßÞÒ ÔØÐÓàÐÜÜ: Column (ÁâÞÛÑçÐâÐï), 
Stacked column (ÈâÐÑÕÛìÝÐï áâÞÛÑçÐâÐï), Line (»ØÝÕÙÝÐï), Pie (ÁÕÚâÞàÝÐï), Bar 
(³ØáâÞÓàÐÜÜÐ), Stacked bar (ÈâÐÑÕÛìÝÐï ÓØáâÞÓàÐÜÜÐ) Ø X/Y scatter (³àÐäØÚ X/Y).

1 ²ëÑÕàØâÕ ÔØÐßÐ×ÞÝ ïçÕÕÚ âÐÑÛØæë, ÚÞâÞàëÕ áÞÔÕàÖÐâ ÔÐÝÝëÕ ÔÛï ÝÞÒÞÙ 
ÔØÐÓàÐÜÜë.

2 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ Insert > New chart (½ÞÒÐï ÔØÐÓàÐÜÜÐ). 
¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ.

3 ²ÒÕÔØâÕ áÛÕÔãîéØÕ ÔÐÝÝëÕ: Chart name (½Ð×ÒÐÝØÕ ÔØÐÓàÐÜÜë), Chart type 
(ÂØß ÔØÐÓàÐÜÜë), 3-D, Background colour (ÆÒÕâ äÞÝÐ) Ø Axis colour (ÆÒÕâ ÞáÕÙ).



Copyright © 2000-2002 Nokia. All rights reserved.

31

ºà
Ðâ

ÚÞ
Õ 

àã
ÚÞ

ÒÞ
Ôá

âÒ
Þ4 ½ÐÖÜØâÕ Close (·ÐÚàëâì) ÔÛï áÞ×ÔÐÝØï ÝÞÒÞÙ ÔØÐÓàÐÜÜë ØÛØ Cancel ÔÛï 

ÞâÜÕÝë ÞßÕàÐæØØ.

¿àØÛÞÖÕÝØÕ Presentation viewer
´Ûï âÞÓÞ, çâÞÑë ÞâÚàëâì ßàÕ×ÕÝâÐæØî, ÝÐÖÜØâÕ Open (¾âÚàëâì) ÝÐ ÓÛÐÒÝÞÜ 
íÚàÐÝÕ ßàØÛÞÖÕÝØï Presentation viewer, ÚÞâÞàëÙ ßÞ×ÒÞÛïÕâ ÒëÑàÐâì Ø ÞâÚàëâì 
ÔÞÚãÜÕÝâ. ½ÐÖÜØâÕ Close (·ÐÚàëâì), çâÞÑë ×ÐÚàëâì ßàØÛÞÖÕÝØÕ.

ÁÞÒÕâ. ²ëÑÕàØâÕ 
ÜÐáèâÐÑ Ø×ÞÑàÐÖÕÝØï, 
ÝÐØÑÞÛÕÕ ãÔÞÑÝëÙ ÔÛï 
ßàÞáÜÞâàÐ ßàÕ×ÕÝâÐæØØ.

¿ÞáÛÕ ÞâÚàëâØï ÔÞÚãÜÕÝâÐ ÝÐ ÔØáßÛÕÙ ÒëÒÞÔØâáï ÒÕàåÝïï çÐáâì ßÕàÒÞÓÞ 
áÛÐÙÔÐ. ´Ûï ßÕàÕåÞÔÐ Ú áÛÕÔãîéÕÜã áÛÐÙÔã ÝÐÖÜØâÕ Next (ÁÛÕÔãîéØÙ) ØÛØ 
Enter. ´Ûï ßÕàÕåÞÔÐ Ú ßàÕÔëÔãéÕÜã áÛÐÙÔã ÝÐÖÜØâÕ Previous (¿àÕÔëÔãéØÙ). 
´Ûï ßàÞÚàãâÚØ âÕÚãéÕÓÞ áÛÐÙÔÐ ßÞÛì×ãÙâÕáì ÚÛÐÒØèÐÜØ áÞ áâàÕÛÚÐÜØ.

¿àØÛÞÖÕÝØÕ File manager
¿àØÛÞÖÕÝØÕ File manager (´ØáßÕâçÕà äÐÙÛÞÒ) áÛãÖØâ ÔÛï ãßàÐÒÛÕÝØï 
áÞÔÕàÖØÜëÜ àÐ×ÛØçÝëå ßÐßÞÚ Ø Øå áÒÞÙáâÒÐÜØ.

² ÞÚÝÕ ßÐßÞÚ ÞâÞÑàÐÖÐÕâáï ÔÕàÕÒÞ, áÞÔÕàÖÐéÕÕ ßÐßÚØ ÔÒãå ÚÞàÝÕÒëå 
ÚÐâÐÛÞÓÞÒ: ÚÞÜÜãÝØÚÐâÞàÐ Ø ÚÐàâë ßÐÜïâØ.

² ÔÕàÕÒÕ ßÐßÞÚ ÚÞÜÜãÝØÚÐâÞàÐ ÝÐåÞÔØâáï ßÐßÚÐ C:\Documents\ (´ÞÚãÜÕÝâë), Ò 
ÚÞâÞàÞÙ àÐáßÞÛÞÖÕÝë çÕâëàÕ áâÐÝÔÐàâÝëÕ ßÐßÚØ: \Documents\Downloaded\ 
(·ÐÓàãÖÕÝÝëÕ ÔÞÚãÜÕÝâë), \Documents\Photo gallery\ (ÄÞâÞÐÛìÑÞÜ), 
\Documents\Templates\ (ÈÐÑÛÞÝë) Ø \Documents\Tones\ (ÂÞÝÐÛìÝëÕ áØÓÝÐÛë).
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Þ ² ÞÚÝÕ äÐÙÛÞÒ ÞâÞÑàÐÖÐÕâáï áßØáÞÚ ÒáÕå äÐÙÛÞÒ, ÚÞâÞàëÕ áÞÔÕàÖÐâáï 
Ò ÚÞàÝÕÒÞÜ ÚÐâÐÛÞÓÕ ØÛØ ßÐßÚÕ, ÒëÔÕÛÕÝÝÞÙ Ò ÛÕÒÞÜ ÞÚÝÕ. ² ×ÐÓÞÛÞÒÚÕ ÞÚÝÐ 
áßØáÚÐ äÐÙÛÞÒ ÒëÒÞÔØâáï ßãâì Ú ÒëÔÕÛÕÝÝÞÜã Ò ÔÐÝÝëÙ ÜÞÜÕÝâ äÐÙÛã. ¾ÚÝÞ 
äÐÙÛÞÒ âÐÚÖÕ áÞÔÕàÖØâ áÒï×ÐÝÝëÕ á ßàØÛÞÖÕÝØïÜØ ×ÝÐçÚØ, ØÜÕÝÐ Ø ÔÐâë 
ßÞáÛÕÔÝÕÓÞ Ø×ÜÕÝÕÝØï äÐÙÛÞÒ. ÄÐÙÛë ÞâÞÑàÐÖÐîâáï Ò ÐÛäÐÒØâÝÞÜ ßÞàïÔÚÕ.

´Ûï ßàÞáÜÞâàÐ áÞÔÕàÖØÜÞÓÞ ßÐßÚØ

1 ²ëÑÕàØâÕ ßÐßÚã Ò ÛÕÒÞÜ ÞÚÝÕ ÔÕàÕÒÐ ßÐßÞÚ Ø ÝÐÖÜØâÕ Open (¾âÚàëâì). 
¾âÚàÞÕâáï ÞÚÝÞ, áÞÔÕàÖÐéÕÕ ÒáÕ ßÐßÚØ Ø äÐÙÛë àÞÔØâÕÛìáÚÞÙ ßÐßÚØ.

2 ´Ûï ßàÞáÜÞâàÐ ÛîÑÞÙ ßÐßÚØ ÒëÑÕàØâÕ ÕÕ Ø ÝÐÖÜØâÕ Open.
3 ´Ûï ÒÞ×ÒàÐâÐ ÝÐ ÓÛÐÒÝëÙ íÚàÐÝ ÝÐÖÜØâÕ Done (³ÞâÞÒÞ).

´Ûï âÞÓÞ, çâÞÑë ÞâÚàëâì äÐÙÛ

1 ²ëÑÕàØâÕ äÐÙÛ Ø ÝÐÖÜØâÕ Open (¾âÚàëâì). ÄÐÙÛ ÑãÔÕâ ÞâÚàëâ 
Ò áÞÞâÒÕâáâÒãîéÕÜ ßàØÛÞÖÕÝØØ. 

2 ´Ûï ÒÞ×ÒàÐâÐ ÝÐ ÓÛÐÒÝëÙ íÚàÐÝ ÝÐÖÜØâÕ Close folder (·ÐÚàëâì ßÐßÚã).

´Ûï áÞ×ÔÐÝØï ÝÞÒÞÙ ßÐßÚØ

1 ² ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï File manager ÝÐÖÜØâÕ ÚÛÐÒØèã Menu Ø 
ÒëÑÕàØâÕ File > New folder. ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ. 

2 ²ÒÕÔØâÕ ÝÐ×ÒÐÝØÕ ÝÞÒÞÙ ßÐßÚØ.

´Ûï ßÞØáÚÐ ßÐßÞÚ Ø äÐÙÛÞÒ

1 ²ëÑÕàØâÕ ßÐßÚã ØÛØ ÜÞÔãÛì ßÐÜïâØ, Ò ÚÞâÞàÞÜ âàÕÑãÕâáï ÒëßÞÛÝØâì 
ßÞØáÚ. 

2 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu > Tools > Find. ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ. 
3 ²ÒÕÔØâÕ Ò ßÞÛÕ áâàÞÚã ßÞØáÚÐ. 
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Þ4 ´Ûï ÞßàÕÔÕÛÕÝØï ÔÞßÞÛÝØâÕÛìÝëå ÚàØâÕàØÕÒ ßÞØáÚÐ ÝÐÖÜØâÕ Options 

(¿ÐàÐÜÕâàë).
´Ûï Ø×ÜÕÝÕÝØï ×ÝÐçÕÝØï íÛÕÜÕÝâÞÒ áßØáÚÐ ÝÐÖÜØâÕ Change (¸×ÜÕÝØâì). 
·ÐÒÕàèØÒ ÒÒÞÔ ÔÐÝÝëå, ÝÐÖÜØâÕ Close (·ÐÚàëâì).

5 ´Ûï ×ÐßãáÚÐ ßÞØáÚÐ ÝÐÖÜØâÕ Find (½ÐÙâØ).
´Ûï âÞÓÞ, çâÞÑë ßàÕàÒÐâì ßÞØáÚ, ÝÐÖÜØâÕ Stop (ÁâÞß).

6 ¿ÞáÛÕ ×ÐÒÕàèÕÝØï ßÞØáÚÐ ÝÐÖÜØâÕ Open (¾âÚàëâì), çâÞÑë ÞâÚàëâì 
ÝÐÙÔÕÝÝãî ßÐßÚã ØÛØ äÐÙÛ.
´Ûï ×ÐßãáÚÐ ÝÞÒÞÓÞ ßÞØáÚÐ ÝÐÖÜØâÕ New find (½ÞÒëÙ ßÞØáÚ).

7 ´Ûï ÒÞ×ÒàÐâÐ Ò ÓÛÐÒÝëÙ íÚàÐÝ ÝÐÖÜØâÕ Close.

³àãßßÐ Extras
´Ûï ÒëÒÞÔÐ ÝÐ ÔØáßÛÕÙ ÔÞßÞÛÝØâÕÛìÝëå ßàØÛÞÖÕÝØÙ ÝÐÖÜØâÕ ÚÛÐÒØèã 
ßàØÛÞÖÕÝØï Extras. ´Ûï âÞÓÞ, çâÞÑë ×ÐßãáâØâì ßàØÛÞÖÕÝØÕ, á ßÞÜÞéìî 
ÚÛÐÒØèØ áÞ áâàÕÛÚÐÜØ ÒëÔÕÛØâÕ ×ÝÐçÞÚ ßàØÛÞÖÕÝØï Ø ÝÐÖÜØâÕ Open 
(¾âÚàëâì). 

´ÞßÞÛÝØâÕÛìÝëÕ ßàØÛÞÖÕÝØï ÜÞÖÝÞ ãáâÐÝÞÒØâì á ÚÞÜßÐÚâ-ÔØáÚÐ Ø× 
ÚÞÜßÛÕÚâÐ ßÞáâÐÒÚØ.

¿àØÛÞÖÕÝØÕ Clock
¿àØÛÞÖÕÝØÕ Clock (ÇÐáë) ÒëÒÞÔØâ ÝÐ ÔØáßÛÕÙ ÜÕáâÝÞÕ ÒàÕÜï Ø ÔÐâã, Ð âÐÚÖÕ 
ÒàÕÜï Ø ÔÐâã Ò ÝÕáÚÞÛìÚØå ÔàãÓØå ÓÞàÞÔÐå Ø áâàÐÝÐå/àÕÓØÞÝÐå ÜØàÐ. ² áÞáâÐÒ 
ßàØÛÞÖÕÝØï âÐÚÖÕ ÒåÞÔØâ ÑãÔØÛìÝØÚ.
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Þ ´Ûï ãáâÐÝÞÒÚØ ÑãÔØÛìÝØÚÐ

ÁÞÒÕâ. ·ÒãÚÞÒëÕ 
áØÓÝÐÛë ÔÛï áÞÑëâØÙ 
ÚÐÛÕÝÔÐàï 
ãáâÐÝÐÒÛØÒÐîâáï Ò 
ßàØÛÞÖÕÝØØ Calendar.

1 ½ÐÖÜØâÕ Alarm clock (±ãÔØÛìÝØÚ) ÝÐ ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Clock. 
¾âÚàÞÕâáï ÞÚÝÞ ÑãÔØÛìÝØÚÐ.
°ÚâØÒÝëÕ Ò ÔÐÝÝëÙ ÜÞÜÕÝâ áØÓÝÐÛë ßÕàÕçØáÛÕÝë Ò áßØáÚÕ àïÔÞÜ á 
çÐáÐÜØ.

2 ´Ûï áÞ×ÔÐÝØï ÝÞÒÞÓÞ áØÓÝÐÛÐ ÝÐÖÜØâÕ New alarm (½ÞÒëÙ áØÓÝÐÛ).
´Ûï Ø×ÜÕÝÕÝØï áØÓÝÐÛÐ ÝÐÖÜØâÕ Edit alarm (¸×ÜÕÝØâì áØÓÝÐÛ).
¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ.

3 ²ÒÕÔØâÕ ÔÐÝÝëÕ áØÓÝÐÛÐ ÑãÔØÛìÝØÚÐ, ÝÐßàØÜÕà, ÒàÕÜï (Time).
4 ´Ûï ßÞÔâÒÕàÖÔÕÝØï ÒÒÕÔÕÝÝëå ÔÐÝÝëå ÝÐÖÜØâÕ Close (·ÐÚàëâì).

´Ûï ÒëÚÛîçÕÝØï áØÓÝÐÛÐ ÑãÔØÛìÝØÚÐ

½ÐÖÜØâÕ Stop (ÁâÞß) ØÛØ ÛîÑãî ÚÛÐÒØèã ÝÐ ÚÛÐÒØÐâãàÕ ÚàëèÚØ âÕÛÕäÞÝÐ.

´Ûï âÞÓÞ, çâÞÑë ÞâÚÛîçØâì áØÓÝÐÛ ÑãÔØÛìÝØÚÐ ÝÐ ×ÐÔÐÝÝÞÕ ÒàÕÜï, ÝÐÖÜØâÕ 
Snooze (¿ÞÒâÞà).

¿àØÛÞÖÕÝØÕ Calculator
ºÐÛìÚãÛïâÞà ÜÞÖÕâ àÐÑÞâÐâì Ò ÔÒãå àÕÖØÜÐå: ÚÐÛìÚãÛïâÞà ÔÛï ßàÞáâëå 
ÐàØäÜÕâØçÕáÚØå ÒëçØáÛÕÝØÙ Ø ÚÐÛìÚãÛïâÞà ÔÛï áÛÞÖÝëå ÜÐâÕÜÐâØçÕáÚØå 
àÐáçÕâÞÒ.

¿àÕÔãáÜÞâàÕÝÞ ÔÒÐ áßÞáÞÑÐ ÒëßÞÛÝÕÝØï ÒëçØáÛÕÝØÙ: ßãâÕÜ ÒÒÞÔÐ áØÜÒÞÛÞÒ 
Ò ßÞÛÕ ÒÒÞÔÐ ØÛØ ßãâÕÜ ÒëÑÞàÐ áØÜÒÞÛÞÒ Ø× ßÞÛï äãÝÚæØÙ. ÀÕ×ãÛìâÐâ 
ÒëçØáÛïÕâáï ßÞáÛÕ ÝÐÖÐâØï ÚÛÐÒØèØ Enter ØÛØ =. ¿àÞæÕáá ÒëçØáÛÕÝØÙ Ø 
àÕ×ãÛìâÐâ ÞâÞÑàÐÖÐîâáï Ò ÞÚÝÕ ÒëÒÞÔÐ ÝÐ ÛÕÒÞÙ áâÞàÞÝÕ ÔØáßÛÕï. ´Ûï 
ßÕàÕÜÕéÕÝØï ÜÕÖÔã ßÞÛÕÜ ÒÒÞÔÐ, ÞÚÝÞÜ ÒëÒÞÔÐ Ø ßÞÛÕÜ äãÝÚæØÙ ÝÐÖÜØâÕ 
ÚÛÐÒØèã Tab ØÛØ Change focus (¸×ÜÕÝØâì äÞÚãá).
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Þ¿àØÛÞÖÕÝØÕ Control panel

² ßàØÛÞÖÕÝØØ Control panel (¿ÐÝÕÛì ãßàÐÒÛÕÝØï) ÜÞÖÝÞ ßàÞáÜÞâàÕâì ØÛØ 
Ø×ÜÕÝØâì áÛÕÔãîéØÕ ßÐàÐÜÕâàë: Security (·ÐéØâÐ), Data call barring (·ÐßàÕâ 
Òë×ÞÒÞÒ Ò àÕÖØÜÕ ßÕàÕÔÐçØ ÔÐÝÝëå), Accessories (¿àØÝÐÔÛÕÖÝÞáâØ), Profiles 
(¿àÞäØÛØ), Display (´ØáßÛÕÙ), Certificate manager (ÃßàÐÒÛÕÝØÕ áÕàâØäØÚÐâÐÜØ), 
Date and time (´ÐâÐ Ø ÒàÕÜï), Install/Remove software (ÃáâÐÝÞÒÚÐ/ãÔÐÛÕÝØÕ 
ßàÞÓàÐÜÜ), Internet access (´Þáâãß Ú ̧ ÝâÕàÝÕâ), About product (¾Ñ Ø×ÔÕÛØØ), 
Memory (¿ÐÜïâì), Regional settings (ÀÕÓØÞÝÐÛìÝëÕ ÝÐáâàÞÙÚØ) Ø Default folder 
(¿ÐßÚÐ, ØáßÞÛì×ãÕÜÐï ßÞ ãÜÞÛçÐÝØî).

¸×ÜÕÝÕÝØÕ íâØå ßÐàÐÜÕâàÞÒ ÞÚÐ×ëÒÐÕâ ÒÛØïÝØÕ ÝÐ ÒáÕ ßàØÛÞÖÕÝØï 
ÚÞÜÜãÝØÚÐâÞàÐ.

´Ûï âÞÓÞ, çâÞÑë ÞâÚàëâì ßàØÛÞÖÕÝØÕ ÔÛï Ø×ÜÕÝÕÝØï ßÐàÐÜÕâàÞÒ, á ßÞÜÞéìî 
ÚÛÐÒØèØ áÞ áâàÕÛÚÐÜØ ÒëÑÕàØâÕ âàÕÑãÕÜëÙ ×ÝÐçÞÚ Ø ÝÐÖÜØâÕ Open 
(¾âÚàëâì).

¿àØÛÞÖÕÝØÕ Recorder
ÁÞÒÕâ. Á ßÞÜÞéìî 

ßàØÛÞÖÕÝØï Recorder 
(´ØÚâÞäÞÝ) ×ÐßØáëÒÐîâáï 
×ÒãÚØ Ø àÕçì, ÚÞâÞàëÕ 
×ÐâÕÜ ÜÞÖÝÞ ãáâÐÝÞÒØâì 
Ò ÚÐçÕáâÒÕ áØÓÝÐÛÞÒ 
Òë×ÞÒÐ. ¿ÞÔàÞÑÝÕÕ 
áÜ. ÀãÚÞÒÞÔáâÒÞ 
ßÞÛì×ÞÒÐâÕÛï.

¿àØÛÞÖÕÝØÕ Recorder (´ØÚâÞäÞÝ) ßÞ×ÒÞÛïÕâ ×ÐßØáëÒÐâì âÕÛÕäÞÝÝëÕ 
àÐ×ÓÞÒÞàë Ø ÓÞÛÞáÞÒëÕ ßÐÜïâÚØ. ºàÞÜÕ âÞÓÞ, ÒÞ×ÜÞÖÝÞ ßàÞáÛãèØÒÐÝØÕ Ø 
àÕÔÐÚâØàÞÒÐÝØÕ ×ÐßØáÕÙ Ø ÔàãÓØå ×ÒãÚÞÒëå äÐÙÛÞÒ.
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Þ ÂÕÛÕäÞÝ

ÀØá. 12

²ÚÛîçÕÝØÕ âÕÛÕäÞÝÐ
1 ·ÐÚàÞÙâÕ ÚàëèÚã ÚÞÜÜãÝØÚÐâÞàÐ (ÕáÛØ ÞÝÐ ÞâÚàëâÐ).
2 ´Ûï ÒÚÛîçÕÝØï âÕÛÕäÞÝÐ ÝÐÖÜØâÕ Ø ãÔÕàÖØÒÐÙâÕ ÝÐÖÐâÞÙ ÚÛÐÒØèã . 

µáÛØ ÝÐ ÔØáßÛÕÕ ßÞïÒØâáï ×ÐßàÞá ÚÞÔÐ PIN, ÒÒÕÔØâÕ ÚÞÔ, ÚÞâÞàëÙ 
ßàÕÔÞáâÐÒÛïÕâáï ÒÜÕáâÕ á SIM-ÚÐàâÞÙ, Ø ÝÐÖÜØâÕ ÚÛÐÒØèã , 
àÐáßÞÛÞÖÕÝÝãî ßÞÔ âÕÚáâÞÜ OK ÝÐ ÔØáßÛÕÕ. 

ÂÕÛÕäÞÝ

´ØÝÐÜØÚ

²ØÔ áßÕàÕÔØ ²ØÔ á×ÐÔØ

¼ØÚàÞäÞÝ
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Þ²°¶½¾µ ·°¼µÇ°½¸µ. ½Õ ÒÚÛîçÐÙâÕ ÑÕáßàÞÒÞÔÝëÙ âÕÛÕäÞÝ, ÕáÛØ ÕÓÞ 

ØáßÞÛì×ÞÒÐÝØÕ ×ÐßàÕéÕÝÞ, ÜÞÖÕâ Òë×ÒÐâì ßÞÜÕåØ ØÛØ 
áÞ×ÔÐÒÐâì ãÓàÞ×ã ÑÕ×ÞßÐáÝÞáâØ.

¸ÝÔØÚÐâÞàë ÔØáßÛÕï
¸ÝÔØÚÐâÞàë ÔØáßÛÕï ßàÕÔÝÐ×ÝÐçÕÝë ÔÛï ÞâÞÑàÐÖÕÝØï áÞáâÞïÝØï âÕÛÕäÞÝÐ. 
¿ÕàÕçØáÛÕÝÝëÕ ÝØÖÕ ØÝÔØÚÐâÞàë ÒëÒÞÔïâáï ÝÐ ÔØáßÛÕÙ, ÚÞÓÔÐ âÕÛÕäÞÝ 
ÓÞâÞÒ Ú àÐÑÞâÕ Ø ÝÐ ÔØáßÛÕÕ ÞâáãâáâÒãîâ ÒÒÕÔÕÝÝëÕ ßÞÛì×ÞÒÐâÕÛÕÜ áØÜÒÞÛë.

½°·²°½¸µ ¸ »¾³¾Â¸¿ ÁµÂ¸

- ÃÚÐ×ëÒÐÕâ ÝÐ×ÒÐÝØÕ áÞâÞÒÞÙ áÕâØ, Ú ÚÞâÞàëÙ Ò ÔÐÝÝëÙ ÜÞÜÕÝâ ßÞÔÚÛîçÕÝ 
âÕÛÕäÞÝ.

 Ø èÚÐÛÐ ÝÐÔ áØÜÒÞÛÞÜ

- ¿ÞÚÐ×ëÒÐÕâ ãàÞÒÕÝì àÐÔØÞáØÓÝÐÛÐ Ò âÞçÚÕ àÐáßÞÛÞÖÕÝØï âÕÛÕäÞÝÐ. ÇÕÜ 
ÑÞÛìèÕ ßàïÜÞãÓÞÛìÝØÚÞÒ ÒØÔÝÞ ÝÐ ÔØáßÛÕÕ, âÕÜ ÑÞÛìèÕ ãàÞÒÕÝì áØÓÝÐÛÐ.

 Ø èÚÐÛÐ ÝÐÔ áØÜÒÞÛÞÜ

- ¿ÞÚÐ×ëÒÐÕâ ãàÞÒÕÝì ×ÐàïÔÐ ÐÚÚãÜãÛïâÞàÐ. ÇÕÜ ÑÞÛìèÕ ßàïÜÞãÓÞÛìÝØÚÞÒ 
ÒØÔÝÞ ÝÐ ÔØáßÛÕÕ, âÕÜ ÑÞÛìèÕ ãàÞÒÕÝì ×ÐàïÔÐ ÐÚÚãÜãÛïâÞàÐ.

¸ÝäÞàÜÐæØï Þ ÔàãÓØå ØÝÔØÚÐâÞàÐå ÔØáßÛÕï ßàØÒÕÔÕÝÐ Ò ÓÛÐÒÕ "ÂÕÛÕäÞÝ" 
(Phone) àãÚÞÒÞÔáâÒÐ ßÞ íÚáßÛãÐâÐæØØ.

¿ÞáëÛÚÐ Òë×ÞÒÞÒ Ø ÞâÒÕâ ÝÐ Òë×ÞÒë
´Ûï ßÞáëÛÚØ Òë×ÞÒÐ ÒÒÕÔØâÕ ÚÞÔ ×ÞÝë Ø âÕÛÕäÞÝÝëÙ ÝÞÜÕà, ×ÐâÕÜ 
ÝÐÖÜØâÕ .
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Þ ´Ûï ÞâÒÕâÐ ÝÐ Òë×ÞÒ ÝÐÖÜØâÕ .

´Ûï ×ÐÒÕàèÕÝØï Òë×ÞÒÐ ÝÐÖÜØâÕ . 

ºÛÐÒØèØ ÒëÑÞàÐ
¿ÕàÕÚÛîçÕÝØÕ ßàÞäØÛÕÙ.

 ¿àÞÚàãâÚÐ ÜÕÝî, ßÞÔÜÕÝî Ø ßÐàÐÜÕâàÞÒ. ² àÕÖØÜÕ ÞÖØÔÐÝØï 
(ÚÞÓÔÐ ÞâáãâáâÒãîâ ÐÚâØÒÝëÕ Òë×ÞÒë) ÚÛÐÒØèØ ßàÞÚàãâÚØ ÜÞÖÝÞ 
ØáßÞÛì×ÞÒÐâì ÔÛï ßàÞáÜÞâàÐ áÞÔÕàÖØÜÞÓÞ ßÐÜïâØ. ²Þ ÒàÕÜï àÐ×ÓÞÒÞàÐ 
ÚÛÐÒØèØ ßàÞÚàãâÚØ áÛãÖÐâ ÔÛï àÕÓãÛØàÞÒÚØ ÓàÞÜÚÞáâØ.

 –  ÆØäàÞÒëÕ ÚÛÐÒØèØ (âÐÚÖÕ ØáßÞÛì×ãîâáï ÔÛï ÒÒÞÔÐ ÑãÚÒ). ́ Ûï 
Òë×ÞÒÐ áÒÞÕÓÞ ÐÒâÞÞâÒÕâçØÚÐ ÝÐÖÜØâÕ Ø ãÔÕàÖØÒÐÙâÕ ÝÐÖÐâÞÙ ÚÛÐÒØèã .

 ßàÕÔÝÐ×ÝÐçÕÝë ÔÛï ÒëßÞÛÝÕÝØï áßÕæØÐÛìÝëå äãÝÚæØÙ. ¿àØ 
ØáßÞÛì×ÞÒÐÝØØ ÔÒãå âÕÛÕäÞÝÝëå ÛØÝØÙ ÔÛï ßÕàÕÚÛîçÕÝØï ÜÕÖÔã ÛØÝØïÜØ 
ÝÐÖÜØâÕ Ø ãÔÕàÖØÒÐÙâÕ ÝÐÖÐâÞÙ ÚÛÐÒØèã . 

 ½Ð×ÝÐçÕÝØÕ íâØå ÔÒãå ÚÛÐÒØè ÒëÑÞàÐ ÞßàÕÔÕÛïÕâáï âÕÚáâÞÜ, 
ÚÞâÞàëÙ ÒëÒÞÔØâáï Ò ÝØÖÝÕÙ áâàÞÚÕ ÔØáßÛÕï.

¿àØÜÕçÐÝØÕ. ¼ØÚàÞäÞÝ Ø ÔØÝÐÜØÚ ÝÐåÞÔïâáï ÝÐ ÞÑàÐâÝÞÙ áâÞàÞÝÕ 
âÕÛÕäÞÝÐ.
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ÞÄÞàãÜ Nokia

Nokia Wireless Data Forum — íâÞ web-ãáÛãÓÐ, ÐÔàÕáÞÒÐÝÝÐï âÕÜ, ÚâÞ 
×ÐÝØÜÐÕâáï àÐ×àÐÑÞâÚÞÙ ßàØÛÞÖÕÝØÙ Ø ãáÛãÓ ÔÛï ßÛÐâäÞàÜ Nokia. Web-ã×ÕÛ 
áÞÔÕàÖØâ ØÝäÞàÜÐæØî Þ àÐ×ÛØçÝëå ÒÞ×ÜÞÖÝÞáâïå àÐ×ÒØâØï, Ð âÐÚÖÕ Þ 
ÔÞáâãßÝëå ßàÞÓàÐÜÜÐå ÜÐàÚÕâØÝÓÞÒÞÙ ßÞÔÔÕàÖÚØ àÐ×àÐÑÞâçØÚÞÒ, áØáâÕÜÝëå 
ØÝâÕÓàÐâÞàÞÒ Ø ÔàãÓØå ßÐàâÝÕàÞÒ Nokia.

ºàÞÜÕ âÞÓÞ, Nokia Wireless Data Forum ßàÕÔÛÐÓÐÕâ ßÞÔÔÕàÖÚã ÚÞÜÜãÝØÚÐâÞàÐ 
Nokia 9210i Communicator Ø ÔàãÓØå Ø×ÔÕÛØÙ ÑÕáßàÞÒÞÔÝÞÙ áÒï×Ø Nokia. ½Ð 
íâØå web-áâàÐÝØæÐå ÜÞÖÝÞ ÝÐÙâØ ÔÞÚãÜÕÝâÐæØî, ÔàÐÙÒÕàë, ÞßØáÐÝØï, 
áÒÕÔÕÝØï Þ áÞÒÜÕáâØÜÞáâØ Ø â. ß.

´Ûï âÕå, ÚâÞ ØÝâÕàÕáãÕâáï ßÕàÕÔÐçÕÙ ÔÐÝÝëå ßÞ ÑÕáßàÞÒÞÔÝëÜ áÕâïÜ, web-
ã×ÕÛ ßàÕÔÛÐÓÐÕâ ÔÞÚãÜÕÝâÐæØî ßÞ àÐ×ÛØçÝëÜ âÕåÝÞÛÞÓØïÜ, áÒï×ÐÝÝëÜ 
á ÑÕáßàÞÒÞÔÝÞÙ ßÕàÕÔÐçÕÙ ÔÐÝÝëå.

°ÔàÕá Nokia Wireless Data Forum http://www.forum.nokia.com

Club Nokia
Club Nokia ßàÕÔÛÐÓÐÕâ ØáçÕàßëÒÐîéãî ØÝäÞàÜÐæØî, ÚÞâÞàÐï ßÞÜÞÖÕâ 
Ò ßÞÛÝÞÙ ÜÕàÕ ÒÞáßÞÛì×ÞÒÐâìáï ÒÞ×ÜÞÖÝÞáâïÜØ âÕÛÕäÞÝ Nokia. ² ÚÐçÕáâÒÕ 
çÛÕÝÐ Club Nokia ²ë ßÞÛãçÐÕâÕ ÔÞáâãß ÚÞ ÜÝÞÓÞçØáÛÕÝÝëÜ ßÞÛÕ×ÝëÜ 
ãáÛãÓÐÜ. ÁîÔÐ ÞâÝÞáïâáï ÞßÕàÐâØÒÝÞÕ ÞÑáÛãÖØÒÐÝØÕ Ø ßÞÔÔÕàÖÚÐ, 
ßàÕÔÒÐàØâÕÛìÝëÕ ÞÑ×Þàë ßàÞÔãÚæØØ Nokia, áßÕæØÐÛìÝëÕ ßàÕÔÛÞÖÕÝØï, 
ÔÞáâãß Ú web-ã×Ûã Club Nokia Ø â. ß.
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Þ µáÛØ ã ²Ðá ÒÞ×ÝØÚÝãâ ÒÞßàÞáë, áßÕæØÐÛØáâë ßÞ âÕÛÕäÞÝÐÜ Nokia ÒáÕÓÔÐ 
Ú ²ÐèØÜ ãáÛãÓÐÜ. ²ë ßÞÛãçÐÕâÕ áÒÞÑÞÔÝëÙ ÔÞáâãß Ú âÕÛÕäÞÝÝÞÜã æÕÝâàã 
áÞßàÞÒÞÖÔÕÝØï ßàÞÔãÚæØØ Club Nokia CareLine. ²ë âÐÚÖÕ ßÞÛãçÐÕâÕ ÔÞáâãß 
Ú áÛãÖÑÕ Club Nokia Instant Service — áÕàÒØáÝÞÜã æÕÝâàã ÔÛï 
×ÐàÕÓØáâàØàÞÒÐÝÝëå çÛÕÝÞÒ Club Nokia. ÁÕâì ÞÑáÛãÖØÒÐÝØï Club Nokia 
ÞåÒÐâëÒÐÕâ Òáî µÒàÞßã. 

ÁÐÜëÙ ÞßÕàÐâØÒÝëÙ ÔÞáâãß Ú ãáÛãÓÐÜ Club Nokia, ØÝäÞàÜÐæØØ Þ ßàÞÔãÚæØØ, 
áßÕæØÐÛìÝëÜ ßàÕÔÛÞÖÕÝØïÜ, ÝÞÒÞáâïÜ Þ ßàÕÔáâÞïéØå áÞÑëâØïå Ø 
áÞàÕÒÝÞÒÐÝØïå — íâÞ web-ã×ÕÛ Club Nokia. Club Nokia ÔÞáâãßÕÝ Ò ÑÞÛìèØÝáâÒÕ 
ÕÒàÞßÕÙáÚØå áâàÐÝ - ÒáâãßÐÙâÕ ÑÕ× ÚÞÛÕÑÐÝØÙ Ò ÝÐè ÚÛãÑ! °ÔàÕá Club Nokia 
http://www.club.nokia.com.
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ßàØÝÐÔÛÕÖÝÞáâØ
ÁÞÒÕâ. ¿àØÜÕÝÕÝØÕ 

ÞàØÓØÝÐÛìÝëå 
ßàØÝÐÔÛÕÖÝÞáâÕÙ Nokia 
ÒÕáìÜÐ àÐ×ÝÞÞÑàÐ×ÝÞ: 
ÞÑÞàãÔÞÒÐÝØÕ 
ÒëáÞÚÞáÚÞàÞáâÝÞÙ 
ßÕàÕÔÐçØ ÔÐÝÝëå, 
ßàÐÚâØçÝëÕ 
ÜØÝØÓÐàÝØâãàë, 
ÐÒâÞÜÞÑØÛìÝëÕ Ø áÕâÕÒëÕ 
×ÐàïÔÝëÕ ãáâàÞÙáâÒÐ.

¾àØÓØÝÐÛìÝëÕ ßàØÝÐÔÛÕÖÝÞáâØ Nokia ÞÑÕáßÕçÐâ ÞßâØÜÐÛìÝãî àÐÑÞâã 
ÜÞÑØÛìÝÞÓÞ âÕÛÕäÞÝÐ Nokia Ò èØàÞÚÞÜ ÔØÐßÐ×ÞÝÕ ãáÛÞÒØÙ íÚáßÛãÐâÐæØØ. 
´ÞßÞÛÝØâÕÛìÝëÕ ßàØÝÐÔÛÕÖÝÞáâØ ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210i 
Communicator àÐ×àÐÑÞâÐÝë ÔÛï ãÔÞÒÛÕâÒÞàÕÝØï ßÞâàÕÑÝÞáâÕÙ àÐ×ÛØçÝëå 
ÚÐâÕÓÞàØÙ ßÞÛì×ÞÒÐâÕÛÕÙ Ò àÐ×ÛØçÝëå ãáÛÞÒØïå áÒï×Ø.

¿àØÜÕçÐÝØÕ. ÁÛÕÔãÕâ ØáßÞÛì×ÞÒÐâì âÞÛìÚÞ âÕ ÐÚÚãÜãÛïâÞàÝëÕ ÑÐâÐàÕØ, 
×ÐàïÔÝëÕ ãáâàÞÙáâÒÐ Ø ßàØÝÐÔÛÕÖÝÞáâØ, ÚÞâÞàëÕ ÞÔÞÑàÕÝë 
Ø×ÓÞâÞÒØâÕÛÕÜ ÔÛï ÔÐÝÝÞÙ ÜÞÔÕÛØ ÚÞÜÜãÝØÚÐâÞàÐ. 
¸áßÞÛì×ÞÒÐÝØÕ ãáâàÞÙáâÒ ÛîÑëå ÔàãÓØå âØßÞÒ ßàØÒÞÔØâ 
Ú ÞâÜÕÝÕ ÒáÕå ÞâÝÞáïéØåáï Ú ÚÞÜÜãÝØÚÐâÞàã ÓÐàÐÝâØÙ Ø 
ßàÕÔáâÐÒÛïÕâ ãÓàÞ×ã ÑÕ×ÞßÐáÝÞáâØ.
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Ø ÃáâàÞÙáâÒÐ ßØâÐÝØï

±ÐâÐàÕï ßÞÒëèÕÝÝÞÙ ÜÞéÝÞáâØ BLL-3

ÀØá. 13

±ÐâÐàÕï ßÞÒëèÕÝÝÞÙ ÜÞéÝÞáâØ BLL-3 — íâÞ ßÛÞáÚØÙ, ÜÞéÝëÙ ÛØâØÙ-ØÞÝÝëÙ 
ÐÚÚãÜãÛïâÞà ÕÜÚÞáâìî 1300 Ü°ç á ßàÞÔÞÛÖØâÕÛìÝëÜ ÒàÕÜÕÝÕÜ àÐÑÞâë. 
² ×ÐÒØáØÜÞáâØ Þâ ãáÛÞÒØÙ íÚáßÛãÐâÐæØØ ÐÚÚãÜãÛïâÞà ÞÑÕáßÕçØÒÐÕâ ÒàÕÜï 
àÐÑÞâë âÕÛÕäÞÝÐ Ò àÕÖØÜÕ àÐ×ÓÞÒÞàÐ 4-10 ç, Ò àÕÖØÜÕ ÞÖØÔÐÝØï 80-230 ç.

²Õá ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210i Communicator á ÐÚÚãÜãÛïâÞàÞÜ áÞáâÐÒÛïÕâ 
244 Ó.
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Ø´ÞàÞÖÝÞÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ ACP-12

ÀØá. 14

ÁÞÒÕâ. ÍâÞ ×ÐàïÔÝÞÕ 
ãáâàÞÙáâÒÞ ÞáÞÑÕÝÝÞ 
ãÔÞÑÝÞ ßàØ ßÞáâÞïÝÝëå 
ßÞÕ×ÔÚÐå.

´ÞàÞÖÝÞÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ ACP-12 ÞÑÛÐÔÐÕâ ÜÐÛëÜ ÒÕáÞÜ, 
ßàÞÔÞÛÖØâÕÛìÝëÜ áàÞÚÞÜ áÛãÖÑë Ø àÐÑÞâÐÕâ ßàÐÚâØçÕáÚØ Þâ ÛîÑÞÓÞ áÕâÕÒÞÓÞ 
ÝÐßàïÖÕÝØï. ²Þ ÒàÕÜï ×ÐàïÔÚØ ÚÞÜÜãÝØÚÐâÞàÞÜ ÜÞÖÝÞ ßÞÛì×ÞÒÐâìáï ÚÐÚ 
ÞÑëçÝÞ. ²àÕÜï ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ ÚÞÜÜãÝØÚÐâÞàÐ á ßÞÜÞéìî íâÞÓÞ 
×ÐàïÔÝÞÓÞ ãáâàÞÙáâÒÐ áÞáâÐÒÛïÕâ ßàØÜÕàÝÞ 180 ÜØÝ (Ò ×ÐÒØáØÜÞáâØ Þâ ãàÞÒÝï 
ÞáâÐâÞçÝÞÓÞ ×ÐàïÔÐ ÐÚÚãÜãÛïâÞàÐ).

¿àØÜÕçÐÝØÕ. Á ÚÞÜÜãÝØÚÐâÞàÞÜ ÜÞÖÝÞ âÐÚÖÕ ØáßÞÛì×ÞÒÐâì ßÞàâÐâØÒÝÞÕ 
×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ ACP-9.

´Ûï µÒàÞßë ´Ûï ²ÕÛØÚÞÑàØâÐÝØØ
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Ø ÃáÞÒÕàèÕÝáâÒÞÒÐÝÝÐï ÝÐáâÞÛìÝÐï ßÞÔáâÐÒÚÐ 
DCH-10

ÁÞÒÕâ. ´Ûï ×ÐàïÔÚØ 
ÐÚÚãÜãÛïâÞàÞÒ á ßÞÜÞéìî 
íâÞÙ ßÞÔáâÐÒÚØ âàÕÑãÕâáï 
ÔÞàÞÖÝÞÕ ×ÐàïÔÝÞÕ 
ãáâàÞÙáâÒÞ ACP-9. ´Ûï 
ßÞÔÚÛîçÕÝØï Ú ¿º 
âàÕÑãÕâáï ÚÐÑÕÛì ÐÔÐßâÕàÐ 
RS-232 DLR-2L. 
¿ÞÔÚÛîçÕÝØÕ Ú ¿º 
ÒÞ×ÜÞÖÝÞ âÐÚÖÕ çÕàÕ× 
¸º-ßÞàâ. ÀØá. 15

ÃáÞÒÕàèÕÝáâÒÞÒÐÝÝÐï ÝÐáâÞÛìÝÐï ßÞÔáâÐÒÚÐ DCH-10 ÞçÕÝì ãÔÞÑÝÐ ÔÛï

• ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ, ãáâÐÝÞÒÛÕÝÝÞÓÞ Ò ÚÞÜÜãÝØÚÐâÞà;
• ßÞÔÚÛîçÕÝØï ÚÞÜÜãÝØÚÐâÞàÐ Ú ßÕàáÞÝÐÛìÝÞÜã ÚÞÜßìîâÕàã ÔÛï ßÕàÕÔÐçØ 

ÔÐÝÝëå.

½Ð ÛÕÒÞÙ áâÞàÞÝÕ ßÞÔáâÐÒÚØ ßàÕÔãáÜÞâàÕÝ ØÝäàÐÚàÐáÝëÙ ßÞàâ (áÜ. àØá. 15). 
² ßÞÔáâÐÒÚÕ âÐÚÖÕ ßàÕÔãáÜÞâàÕÝÞ ÓÝÕ×ÔÞ ÔÛï ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ, 
ÞâáÞÕÔØÝÕÝÝÞÓÞ Þâ ÚÞÜÜãÝØÚÐâÞàÐ, çâÞ ÞçÕÝì ãÔÞÑÝÞ ÔÛï ×ÐàïÔÚØ ×ÐßÐáÝëå 
ÐÚÚãÜãÛïâÞàÞÒ. 

ÓÝÕ×ÔÞ ÔÛï ×ÐàïÔÚØ 
×ÐßÐáÝÞÓÞ 
ÐÚÚãÜãÛïâÞàÐ

¸º-ßÞàâ
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Ø·ÐàïÔÚÐ ÐÚÚãÜãÛïâÞàÐ ÚÞÜÜãÝØÚÐâÞàÐ á ßÞÜÞéìî 

ÝÐáâÞÛìÝÞÙ ßÞÔáâÐÒÚØ

1 ¿ÞÔÚÛîçØâÕ ßÞàâÐâØÒÝÞÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ ACP-9 Ú ßÞÔáâÐÒÚÕ.
2 ÃáâÐÝÞÒØâÕ ÚÞÜÜãÝØÚÐâÞà á ãáâÐÝÞÒÛÕÝÝëÜ ÐÚÚãÜãÛïâÞàÞÜ Ò ÝÐáâÞÛìÝãî 

ßÞÔáâÐÒÚã àÐ×êÕÜÞÜ ÒßÕàÕÔ.
3 ²ÚÛîçØâÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Ò áÕâÕÒãî àÞ×ÕâÚã.

·ÐàïÔÚÐ ×ÐßÐáÝÞÓÞ ÐÚÚãÜãÛïâÞàÐ á ßÞÜÞéìî ÝÐáâÞÛìÝÞÙ 
ßÞÔáâÐÒÚØ

1 ¿ÞÔÚÛîçØâÕ ßÞàâÐâØÒÝÞÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Ú ÝÐáâÞÛìÝÞÙ ßÞÔáâÐÒÚÕ.
2 ÃáâÐÝÞÒØâÕ ×ÐßÐáÝÞÙ ÐÚÚãÜãÛïâÞà ÒÞ ÒâÞàÞÕ ÓÝÕ×ÔÞ ßÞ×ÞÛÞçÕÝÝëÜØ 

ÚÞÝâÐÚâÐÜØ ÒßÕàÕÔ. ÁÝÐçÐÛÐ ßàØÖÜØâÕ ÐÚÚãÜãÛïâÞà ÒÝØ×, ×ÐâÕÜ áÛÕÓÚÐ 
ßÞÔâÞÛÚÝØâÕ ÕÓÞ ÝÐ×ÐÔ ÔÞ ×ÐéÕÛÚØÒÐÝØï.

3 ²ÚÛîçØâÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Ò áÕâÕÒãî àÞ×ÕâÚã. ¿àØ íâÞÜ ×ÐÓÞàÐÕâáï 
ØÝÔØÚÐâÞà á ÛÕÒÞÙ áâÞàÞÝë ßÞÔáâÐÒÚØ. ºàÐáÝëÙ æÒÕâ ØÝÔØÚÐâÞàÐ 
ãÚÐ×ëÒÐÕâ, çâÞ ßàÞØáåÞÔØâ ×ÐàïÔÚÐ. ¿ÞáÛÕ ÞÚÞÝçÐÝØï ×ÐàïÔÚØ ØÝÔØÚÐâÞà 
×ÐÓÞàÐÕâáï ×ÕÛÕÝëÜ æÒÕâÞÜ.

4 ´Ûï Ø×ÒÛÕçÕÝØï ÐÚÚãÜãÛïâÞàÐ áÔÒØÝìâÕ ÕÓÞ ÒßÕàÕÔ, ×ÐâÕÜ áÝØÜØâÕ á 
ßÞÔáâÐÒÚØ.

¿àØÜÕçÐÝØÕ. µáÛØ Ò ßÞÔáâÐÒÚÕ ÞÔÝÞÒàÕÜÕÝÝÞ ×ÐàïÖÐÕâáï Ø ÚÞÜÜãÝØÚÐâÞà, 
×ÐàïÔÚÐ ×ÐßÐáÝÞÓÞ ÐÚÚãÜãÛïâÞàÐ ßàØÞáâÐÝÐÒÛØÒÐÕâáï ÔÞ 
ÞÚÞÝçÐÝØï ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ, ãáâÐÝÞÒÛÕÝÝÞÓÞ 
Ò ÚÞÜÜãÝØÚÐâÞà.
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Ø ¿ÞÔÚÛîçÕÝØÕ Ú ¿º

´Ûï ßÞÔÚÛîçÕÝØï Ú ¿º âàÕÑãÕâáï ÚÐÑÕÛì ÐÔÐßâÕàÐ RS-232 DLR-2L:

1 ¿ÞÔÚÛîçØâÕ ÚÐÑÕÛì ÐÔÐßâÕàÐ Ú àÐ×êÕÜã ÝÐ ×ÐÔÝÕÙ áâÞàÞÝÕ ßÞÔáâÐÒÚØ.
2 ¿ÞÔáÞÕÔØÝØâÕ ÔàãÓÞÙ ÚÞÝÕæ ÚÐÑÕÛï Ú ¿º. 
3 ÃáâÐÝÞÒØâÕ ÚÞÜÜãÝØÚÐâÞà Ò ÝÐáâÞÛìÝãî ßÞÔáâÐÒÚã àÐ×êÕÜÞÜ ÒßÕàÕÔ.
4 ·ÐßãáâØâÕ ÝÐ ÚÞÜßìîâÕàÕ ßàÞÓàÐÜÜã PC Suite ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ Nokia 

9210i Communicator ØÛØ ßàØÛÞÖÕÝØÕ ÔÛï àÐÑÞâë á äÐÚá-ÜÞÔÕÜÞÜ.

¼ÞÖÝÞ âÐÚÖÕ ØáßÞÛì×ÞÒÐâì ØÝäàÐÚàÐáÝÞÕ áÞÕÔØÝÕÝØÕ:

1 ²ÚÛîçØâÕ ¸º-ßÞàâë ÚÞÜÜãÝØÚÐâÞàÐ Ø ÚÞÜßìîâÕàÐ.
2 ÃáâÐÝÞÒØâÕ ÚÞÜÜãÝØÚÐâÞà Ò ÝÐáâÞÛìÝãî ßÞÔáâÐÒÚã àÐ×êÕÜÞÜ ÒßÕàÕÔ.
3 ÃáâÐÝÞÒØâÕ ßÞÔáâÐÒÚã âÐÚØÜ ÞÑàÐ×ÞÜ, çâÞÑë ¸º-ßÞàâ ßÞÔáâÐÒÚØ ÑëÛ 

ÝÐßàÐÒÛÕÝ ÝÐ ¸º-ßÞàâ ÚÞÜßìîâÕàÐ. ÀÐááâÞïÝØÕ ÜÕÖÔã ÔÒãÜï ¸º-ßÞàâÐÜØ 
ÝÕ ÔÞÛÖÝÞ ßàÕÒëèÐâì 30 áÜ.

4 ·ÐßãáâØâÕ ÝÐ ÚÞÜßìîâÕàÕ ßàÞÓàÐÜÜã PC Suite for Nokia 9210i Communicator 
ØÛØ ßàØÛÞÖÕÝØÕ ÔÛï àÐÑÞâë á äÐÚá-ÜÞÔÕÜÞÜ.

´Ûï áØÝåàÞÝØ×ÐæØØ ÔÐÝÝëå ÜÕÖÔã ÚÞÜÜãÝØÚÐâÞàÞÜ Ø ßàÞÓàÐÜÜÞÙ 
ÞàÓÐÝÐÙ×ÕàÐ ÝÐ ¿º ÔÞáâÐâÞçÝÞ ÞÔØÝ àÐ× ÝÐÖÐâì ÚÛÐÒØèã . 
´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï ßàØÒÕÔÕÝÐ Ò àãÚÞÒÞÔáâÒÕ ßÞÛì×ÞÒÐâÕÛï 
ßàÞÓàÐÜÜÝÞÓÞ ÞÑÕáßÕçÕÝØï PC Suite, ÚÞâÞàÞÕ ÝÐåÞÔØâáï Ò àÐ×ÔÕÛÕ “Using 
Nokia 9210i Communicator” ÝÐ ßàØÛÐÓÐÕÜÞÜ Ú ÚÞÜÜãÝØÚÐâÞàã ÚÞÜßÐÚâ-ÔØáÚÕ.
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Ø°ÒâÞÜÞÑØÛìÝëÕ ßàØÝÐÔÛÕÖÝÞáâØ

ÃáÞÒÕàèÕÝáâÒÞÒÐÝÝëÙ ÐÒâÞÜÞÑØÛìÝëÙ 
ÚÞÜßÛÕÚâ ÓàÞÜÚÞÙ áÒï×Ø CARK109

ÀØá. 16
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Ø ÁÞÒÕâ. ²àÕÜï ×ÐàïÔÚØ 
ÐÚÚãÜãÛïâÞàÞÒ áÞÒßÐÔÐÕâ 
áÞ ÒàÕÜÕÝÕÜ ×ÐàïÔÚØ á 
ßÞÜÞéìî 
ÑëáâàÞÔÕÙáâÒãîéÕÓÞ 
ÔÞàÞÖÝÞÓÞ ×ÐàïÔÝÞÓÞ 
ãáâàÞÙáâÒÐ ACP-9.

ÃáÞÒÕàèÕÝáâÒÞÒÐÝÝëÙ ÐÒâÞÜÞÑØÛìÝëÙ ÚÞÜßÛÕÚâ ÓàÞÜÚÞÙ áÒï×Ø CARK109 
ÞÑÕáßÕçØÒÐÕâ ãÔÞÑÝãî ÒÞ×ÜÞÖÝÞáâì ßÞÛì×ÞÒÐâìáï ÚÞÜÜãÝØÚÐâÞàÞÜ 
Ò ÐÒâÞÜÞÑØÛÕ ÑÕ× ÝÕÞÑåÞÔØÜÞáâØ ÔÕàÖÐâì ÕÓÞ Ò àãÚÕ. °ÒâÞÜÞÑØÛìÝëÙ 
ÚÞÜßÛÕÚâ ÞáãéÕáâÒÛïÕâ ßÞÔ×ÐàïÔÚã ÐÚÚãÜãÛïâÞàÐ ÚÞÜÜãÝØÚÐâÞàÐ. º ÜÞÝâÐÖã 
ÐÒâÞÜÞÑØÛìÝÞÓÞ ÚÞÜßÛÕÚâÐ ÔÞßãáÚÐÕâáï âÞÛìÚÞ ÚÒÐÛØäØæØàÞÒÐÝÝëÙ 
ßÕàáÞÝÐÛ. 

ÀØá. 17

² ÚÞÜßÛÕÚâ ÒåÞÔïâ áÛÕÔãîéØÕ ÚÞÜßÞÝÕÝâë: ãÛãçèÕÝÝëÙ ÐÚâØÒÝëÙ 
ÐÒâÞÜÞÑØÛìÝëÙ ÔÕàÖÐâÕÛì CRM-1 (ßÞÚÐ×ÐÝ ÝÐ àØá. 17), 
ãáÞÒÕàèÕÝáâÒÞÒÐÝÝëÙ ÑÛÞÚ ÓàÞÜÚÞÙ áÒï×Ø HFU-2, ÜØÚàÞäÞÝ HFM-8 Ø 
ÒëÝÞáÝÞÙ ÔØÝÐÜØÚ HFS-12. ºàÞÜÕ âÞÓÞ, Ú ÚÞÜßÛÕÚâã ÜÞÖÝÞ ßÞÔÚÛîçØâì 
ÔÞßÞÛÝØâÕÛìÝãî âÕÛÕäÞÝÝãî âàãÑÚã HSU-1, Ð âÐÚÖÕ ÔÞßÞÛÝØâÕÛìÝãî ÐÝâÕÝÝã 
AMD-2, ÚÞâÞàÐï ßÞÒëèÐÕâ ÚÐçÕáâÒÞ áÒï×Ø Ø ãÒÕÛØçØÒÐÕâ àÐÔØãá ÔÕÙáâÒØï 
(ÞÑÐ ÚÞÜßÞÝÕÝâÐ ÝÕÞÑåÞÔØÜÞ ßàØÞÑàÕáâØ ÞâÔÕÛìÝÞ). 

ÃáâÐÝÞÒÚÐ ÚÞÜÜãÝØÚÐâÞàÐ Ò ÔÕàÖÐâÕÛì

1 ·ÐÚàÞÙâÕ ÚàëèÚã ÚÞÜÜãÝØÚÐâÞàÐ Ø ßÞÒÕàÝØâÕ ÐÝâÕÝÝã Ò ×ÐÚàëâÞÕ 
ßÞÛÞÖÕÝØÕ.

2 ÃáâÐÝÞÒØâÕ ÚÞÜÜãÝØÚÐâÞà Ò ÔÕàÖÐâÕÛì ÐÒâÞÜÞÑØÛìÝÞÓÞ ÚÞÜßÛÕÚâÐ 
àÐ×êÕÜÞÜ ÒßÕàÕÔ.
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Ø3 °ÚÚãàÐâÝÞ, çâÞÑë ÝÕ ßÞÒàÕÔØâì àÐ×êÕÜë, ÝÐÖÜØâÕ ÝÐ ÚÞÜÜãÝØÚÐâÞà ÒÝØ× 

ÔÞ ÕÓÞ äØÚáÐæØØ Ò ÔÕàÖÐâÕÛÕ.

¿ÞáëÛÚÐ Òë×ÞÒÐ á ßÞÜÞéìî ÐÒâÞÜÞÑØÛìÝÞÓÞ ÚÞÜßÛÕÚâÐ

1 ²ÒÕÔØâÕ á ÚÛÐÒØÐâãàë âàÕÑãÕÜëÙ ÝÞÜÕà ØÛØ ÒÞáßÞÛì×ãÙâÕáì äãÝÚæØÕÙ 
ßÞØáÚÐ, çâÞÑë ÝÐÙâØ ØÜï Ø ÝÞÜÕà.

2 ½ÐÖÜØâÕ . ² áÛãçÐÕ ÝÕÞÑåÞÔØÜÞáâØ ÚÞÝäØÔÕÝæØÐÛìÝÞÓÞ àÐ×ÓÞÒÞàÐ 
ßÞÔÝØÜØâÕ âÕÛÕäÞÝÝãî âàãÑÚã (ÕáÛØ ÞÝÐ ãáâÐÝÞÒÛÕÝÐ).

¾âÒÕâ ÝÐ Òë×ÞÒ

1 ½ÐÖÜØâÕ  ØÛØ ßÞÔÝØÜØâÕ âÕÛÕäÞÝÝãî âàãÑÚã  (ÕáÛØ ÞÝÐ ãáâÐÝÞÒÛÕÝÐ).
2 µáÛØ Ò ÐÒâÞÜÞÑØÛìÝÞÜ ßàÞäØÛÕ ãáâÐÝÞÒÛÕÝÐ äãÝÚæØï ÐÒâÞÜÐâØçÕáÚÞÓÞ 

ÞâÒÕâÐ, ÚÞÜÜãÝØÚÐâÞà ÐÒâÞÜÐâØçÕáÚØ ÞâÒÕçÐÕâ ÝÐ ÒåÞÔïéØÕ Òë×ÞÒë.

¿ÕàÕÚÛîçÕÝØÕ Ø× àÕÖØÜÐ ØáßÞÛì×ÞÒÐÝØï âàãÑÚØ Ò àÕÖØÜ 
ÓàÞÜÚÞÙ áÒï×Ø

½ÐÖÜØâÕ ÞÔØÝ àÐ× ÚÛÐÒØèã ÒëÑÞàÐ Options (²ëÑÞà) Ø ßÞÛÞÖØâÕ âàãÑÚã Ò 
âÕçÕÝØÕ 5 áÕÚãÝÔ. µáÛØ ÝÕ ÝÐÖÐâì ÚÛÐÒØèã Options ßÕàÕÔ âÕÜ, ÚÐÚ ßÞÛÞÖØâì 
âàãÑÚã, áÒï×ì ÑãÔÕâ ßàÕàÒÐÝÐ.

·ÐÒÕàèÕÝØÕ Òë×ÞÒÐ

½ÐÖÜØâÕ  ØÛØ ßÞÛÞÖØâÕ âÕÛÕäÞÝÝãî âàãÑÚã (ÕáÛØ ÞÝÐ ãáâÐÝÞÒÛÕÝÐ).
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Ø ´ÐâçØÚ ÒÚÛîçÕÝØï ×ÐÖØÓÐÝØï

´ÐâçØÚ ÒÚÛîçÕÝØï ×ÐÖØÓÐÝØï ÞÑÕáßÕçØÒÐÕâ ÐÒâÞÜÐâØçÕáÚÞÕ ÒÚÛîçÕÝØÕ Ø 
ÒëÚÛîçÕÝØÕ ÝÐåÞÔïéÕÓÞáï Ò ÔÕàÖÐâÕÛÕ ÚÞÜÜãÝØÚÐâÞàÐ, ÚÞÓÔÐ ÔÒØÓÐâÕÛì 
ÐÒâÞÜÞÑØÛï ×ÐÒÞÔØâáï ØÛØ ÓÛãèØâáï. ÍâÞ ßàÕÔÞâÒàÐâØâ àÐ×àïÔÚã 
ÐÒâÞÜÞÑØÛìÝÞÓÞ ÐÚÚãÜãÛïâÞàÐ, ÕáÛØ ÚÞÜÜãÝØÚÐâÞà áÛãçÐÙÝÞ ÑëÛ ÞáâÐÒÛÕÝ Ò 
ÔÕàÖÐâÕÛÕ ÝÐ ÔÛØâÕÛìÝÞÕ ÒàÕÜï.

µáÛØ ÔÐâçØÚ ×ÐÖØÓÐÝØï ãáâÐÝÞÒÛÕÝ, ÞÝ àÐÑÞâÐÕâ ßÞáâÞïÝÝÞ. µáÛØ ÔÐâçØÚ 
×ÐÖØÓÐÝØï ÝÕ âàÕÑãÕâáï, ßÞßàÞáØâÕ ÔØÛÕàÐ ÝÕ ãáâÐÝÐÒÛØÒÐâì ÕÓÞ.

¿àØ ÒëÚÛîçÕÝØØ ×ÐÖØÓÐÝØï ÝÐ ÔØáßÛÕÙ ÒëÒÞÔØâáï áÞÞÑéÕÝØÕ “Phone will 
power off, if not used” (µáÛØ âÕÛÕäÞÝ ÝÕ ØáßÞÛì×ãÕâáï, ÕÓÞ ßØâÐÝØÕ ÑãÔÕâ 
ÞâÚÛîçÕÝÞ). ºÞÜÜãÝØÚÐâÞà ÞâÚÛîçÐÕâáï çÕàÕ× 15 á, ÕáÛØ ÝÕ ÝÐÖØÜÐâì ÝØÚÐÚØå 
ÚÛÐÒØè Ø ÝÕ ÒëÝØÜÐâì ÚÞÜÜãÝØÚÐâÞà Ø× ÔÕàÖÐâÕÛï.

¿àØÓÛãèÕÝØÕ ×ÒãÚÐ àÐÔØÞßàØÕÜÝØÚÐ

ÍâÐ äãÝÚæØï ÞÑÕáßÕçØÒÐÕâ ßàØÓÛãèÕÝØÕ ×ÒãÚÐ ÐÒâÞÜÞÑØÛìÝÞÓÞ 
àÐÔØÞßàØÕÜÝØÚÐ ÝÐ ÒàÕÜï âÕÛÕäÞÝÝÞÓÞ àÐ×ÓÞÒÞàÐ (ÕáÛØ âÐÚÐï äãÝÚæØï 
ßàÕÔãáÜÞâàÕÝÐ Ò àÐÔØÞßàØÕÜÝØÚÕ). ¿àØ ãáâÐÝÞÒÚÕ áØáâÕÜë ßÞßàÞáØâÕ ÔØÛÕàÐ 
ÒÚÛîçØâì äãÝÚæØî ßàØÓÛãèÕÝØï ×ÒãÚÐ ßàØÕÜÝØÚÐ.

ÃßàÐÒÛÕÝØÕ íÛÕÚâàÞÔÒØÓÐâÕÛÕÜ ÐÝâÕÝÝë

ÍâÐ äãÝÚæØï (ÕáÛØ ãáâÐÝÞÒÛÕÝÐ) ÞÑÕáßÕçØÒÐÕâ ÒÚÛîçÕÝØÕ íÛÕÚâàÞÔÒØÓÐâÕÛï 
ÐÝâÕÝÝë áÞâÞÒÞÙ áÒï×Ø.
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Ø·ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Þâ ßàØÚãàØÒÐâÕÛï LCH-9

ÀØá. 18

·ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Þâ ßàØÚãàØÒÐâÕÛï LCH-9 ÞÑÕáßÕçØÒÐÕâ ÛÕÓÚØÙ Ø ãÔÞÑÝëÙ 
áßÞáÞÑ ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ ÚÞÜÜãÝØÚÐâÞàÐ Ò ÐÒâÞÜÞÑØÛÕ. ·ÐàïÔÝÞÕ 
ãáâàÞÙáâÒÞ ßÞÔåÞÔØâ Ú ÑÞÛìèØÝáâÒã âØßÞÒ ÐÒâÞÜÞÑØÛìÝëå ÓÝÕ×Ô 
ßàØÚãàØÒÐâÕÛÕÙ. ²ÚÛîçØâÕ ßàÞÒÞÔ ÐÒâÞÜÞÑØÛìÝÞÓÞ ×ÐàïÔÝÞÓÞ ãáâàÞÙáâÒÐ 
Ò àÐ×êÕÜ, àÐáßÞÛÞÖÕÝÝëÙ Ò ÝØÖÝÕÙ çÐáâØ ÚÞÜÜãÝØÚÐâÞàÐ.
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Ø ¸ÝÔØÒØÔãÐÛìÝëÕ ÐÚáÕááãÐàë

¼ØÝØÓÐàÝØâãàÐ (ÝÐãèÝØÚ á ßãÛìâÞÜ 
ãßàÐÒÛÕÝØï) HDC-8L

ÀØá. 19

¼ØÝØÓÐàÝØâãàÐ HDC-8L ÞÑÕáßÕçØÒÐÕâ ÒÞ×ÜÞÖÝÞáâì ÚÞÝäØÔÕÝæØÐÛìÝÞÓÞ 
àÐ×ÓÞÒÞàÐ ÑÕ× ÝÕÞÑåÞÔØÜÞáâØ ÔÕàÖÐâì ÚÞÜÜãÝØÚÐâÞà Ò àãÚÕ. Á ßÞÜÞéìî 
ÚÝÞßÚØ ÔØáâÐÝæØÞÝÝÞÓÞ ãßàÐÒÛÕÝØï, ÚÞâÞàÐï àÐáßÞÛÞÖÕÝÐ Ò ÜØÚàÞäÞÝÝÞÙ 
çÐáâØ ÜØÝØÓÐàÝØâãàë, ÜÞÖÝÞ ÞâÒÕâØâì ÝÐ Òë×ÞÒ Ø ×ÐÒÕàèØâì ÕÓÞ. 
¼ØÝØÓÐàÝØâãàÐ ßÞÔÚÛîçÐÕâáï ÝÕßÞáàÕÔáâÒÕÝÝÞ Ú àÐ×êÕÜã Ò ÝØÖÝÕÙ çÐáâØ 
ÚÞÜÜãÝØÚÐâÞàÐ.
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ØÇÕåÞÛ ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ

ÀØá. 20

ÍâÞâ çÕåÞÛ ßàÕÔÝÐ×ÝÐçÕÝ áßÕæØÐÛìÝÞ ÔÛï ßÕàÕÝÞáÚØ ÚÞÜÜãÝØÚÐâÞàÐ Nokia 
9210i Communicator Ø ßÞáâÐÒÛïÕâáï ÔØÛÕàÐÜØ Nokia.

¼ÞÑØÛìÝëÙ ÞäØá

ºÐàâÐ ßÐÜïâØ
ºÐàâÐ ßÐÜïâØ àÐ×ÜÕàÞÜ á ßÞçâÞÒãî ÜÐàÚã ßàÕÔáâÐÒÛïÕâ áÞÑÞÙ áêÕÜÝÞÕ 
ãáâàÞÙáâÒÞ åàÐÝÕÝØï ÔÐÝÝëå ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ. ºÐàâÐ ßÐÜïâØ ßÞ×ÒÞÛïÕâ 
ãÒÕÛØçØâì ÞÑêÕÜ ßÐÜïâØ, ÔÞáâãßÝÞÙ ÔÛï åàÐÝÕÝØï ÔÐÝÝëå Ø ßàÞÓàÐÜÜ. 
½ÐßàØÜÕà, ÜÞÖÝÞ ×ÐÓàãÖÐâì Ò ÚÞÜÜãÝØÚÐâÞà ÝÞÒëÕ ßàØÛÞÖÕÝØï, Ð âÐÚÖÕ 
áÞåàÐÝïâì àÐ×ÛØçÝëÕ äÐÙÛë (Ø×ÞÑàÐÖÕÝØï, ×ÒãÚÞÒëÕ äÐÙÛë, äÐÚáë Ø 
ÔÞÚãÜÕÝâë). ºÐàâã ßÐÜïâØ ÜÞÖÝÞ ØáßÞÛì×ÞÒÐâì ÔÛï åàÐÝÕÝØï àÐ×ÛØçÝëå 
ßàØÛÞÖÕÝØÙ ØÛØ ÐÔàÕáÝëå ÚÝØÓ.
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Ø ¿àØÜÕçÐÝØÕ. ºÐàâë ßÐÜïâØ, ßàÕÔÝÐ×ÝÐçÕÝÝëÕ ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ Nokia 
9210i, ÝÕ áÞÒÜÕáâØÜë áÞ áâÐàëÜØ ÜÞÔÕÛïÜØ 
ÚÞÜÜãÝØÚÐâÞàÞÒ Nokia, ÞÔÝÐÚÞ ÚÐàâë ßÐÜïâØ Þâ 
ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9110i ÜÞÖÝÞ ØáßÞÛì×ÞÒÐâì Ò 
ÚÞÜÜãÝØÚÐâÞàÕ Nokia 9210i ßÞáÛÕ äÞàÜÐâØàÞÒÐÝØï.

ºÐÑÕÛì ÐÔÐßâÕàÐ RS-232 DLR-2L

ÀØá. 21

ÍâÞâ ãÝØÒÕàáÐÛìÝëÙ ØÝâÕàäÕÙáÝëÙ ÚÐÑÕÛì ÞÑÕáßÕçØÒÐÕâ ÒÞ×ÜÞÖÝÞáâì 
ßÞÔÚÛîçÕÝØï Ú ßÕàáÞÝÐÛìÝÞÜã ÚÞÜßìîâÕàã ÔÛï ÞÑÜÕÝÐ ÔÐÝÝëÜØ 
á ÚÞÜÜãÝØÚÐâÞàÞÜ Nokia 9210i Communicator. ºÐÑÕÛì ßÞÔÚÛîçÐÕâáï 
Ú ßÞáÛÕÔÞÒÐâÕÛìÝÞÜã ßÞàâã RS-232 ßÕàáÞÝÐÛìÝÞÓÞ ÚÞÜßìîâÕàÐ. ºÐÑÕÛì 
ÜÞÖÝÞ âÐÚÖÕ ØáßÞÛì×ÞÒÐâì á ãáÞÒÕàèÕÝáâÒÞÒÐÝÝÞÙ ÝÐáâÞÛìÝÞÙ ßÞÔáâÐÒÚÞÙ 
DCH-10.
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R)3. ¸ÝäÞàÜÐæØï Þ 
áÕàâØäØÚÐæØØ (SAR)
´°½½Ë¹ ¼¾±¸»Ì½Ë¹ Âµ»µÄ¾½ Á¾¾Â²µÂÁÂ²ÃµÂ ½¾À¼°¼ ½° ¾±»ÃÇµ½¸µ 
À°´¸¾Ç°ÁÂ¾Â½¾¹ Í½µÀ³¸µ¹.

ºÞÜÜãÝØÚÐâÞà, ÚÐÚ Ø ÛîÑÞÙ ÜÞÑØÛìÝëÙ âÕÛÕäÞÝ, áÞÔÕàÖØâ ßÕàÕÔÐâçØÚ Ø 
ßàØÕÜÝØÚ àÐÔØÞáØÓÝÐÛÞÒ. ¾Ý áÚÞÝáâàãØàÞÒÐÝ Ø Ø×ÓÞâÞÒÛÕÝ á ãçÕâÞÜ 
âàÕÑÞÒÐÝØÙ ÝÐ ßàÕÔÕÛìÝëÕ ãàÞÒÝØ ÞÑÛãçÕÝØï àÐÔØÞçÐáâÞâÝÞÙ (ÀÇ) íÝÕàÓØÕÙ, 
ãáâÐÝÞÒÛÕÝÝëå Ò ÜÕÖÔãÝÐàÞÔÝëå ÔØàÕÚâØÒÐå (ICNIRP). ¿àÕÔÕÛìÝëÕ ãàÞÒÝØ 
ÞÑÛãçÕÝØï ïÒÛïîâáï áÞáâÐÒÝÞÙ çÐáâìî ÞÑéØå ÔØàÕÚâØÒ Ø ãáâÐÝÐÒÛØÒÐîâ 
ÔÞßãáâØÜëÕ ãàÞÒÝØ àÐÔØÞçÐáâÞâÝÞÓÞ ÞÑÛãçÕÝØï ÔÛï ÝÐáÕÛÕÝØï. ´ÐÝÝëÕ 
ÔØàÕÚâØÒë ÑëÛØ àÐ×àÐÑÞâÐÝë ÝÕ×ÐÒØáØÜëÜØ ÝÐãçÝëÜØ ÞàÓÐÝØ×ÐæØïÜØ ÝÐ 
ÞáÝÞÒÐÝØØ áØáâÕÜÐâØçÕáÚÞÓÞ Ø×ãçÕÝØï Ø âéÐâÕÛìÝÞÙ ßàÞÒÕàÚØ àÕ×ãÛìâÐâÞÒ 
ÝÐãçÝëå ØááÛÕÔÞÒÐÝØÙ. ¿àÕÔÕÛìÝëÕ ãàÞÒÝØ ÞÑÛãçÕÝØï, ÚÞâÞàëÕ ßàØÒÞÔïâáï 
Ò áÞáâÐÒÕ ÞÑéØå ÔØàÕÚâØÒ, ÝÕ ßàÕÒëèÐîâ ÔÞßãáâØÜëå ÓàÐÝØæ ÑÕ×ÞßÐáÝÞÓÞ 
ÞÑÛãçÕÝØï çÕÛÞÒÕÚÐ ÝÕ×ÐÒØáØÜÞ Þâ ÕÓÞ ÒÞ×àÐáâÐ Ø áÞáâÞïÝØï ×ÔÞàÞÒìï.

´Ûï ÞßàÕÔÕÛÕÝØï ãàÞÒÝï ÞÑÛãçÕÝØï, ÒÞ×ÝØÚÐîéÕÓÞ ßàØ àÐÑÞâÕ ÜÞÑØÛìÝÞÓÞ 
âÕÛÕäÞÝÐ, ØáßÞÛì×ãÕâáï ÕÔØÝØæÐ Ø×ÜÕàÕÝØï, ÝÐ×ëÒÐÕÜÐï ãÔÕÛìÝëÜ 
ÚÞíääØæØÕÝâÞÜ ßÞÓÛÞéÕÝØï (SAR). ¿àÕÔÕÛìÝÞÕ ×ÝÐçÕÝØÕ SAR, ãáâÐÝÞÒÛÕÝÝÞÕ 
Ò ÜÕÖÔãÝÐàÞÔÝëå ÔØàÕÚâØÒÐå, àÐÒÝÞ 2,0 ²â/ÚÓ*. ¸×ÜÕàÕÝØï ÚÞíääØæØÕÝâÐ 
SAR ÒëßÞÛÝïîâáï Ò áâÐÝÔÐàâÝÞÜ àÐÑÞçÕÜ ßÞÛÞÖÕÝØØ âÕÛÕäÞÝÐ Ò àÕÖØÜÕ 
ÜÐÚáØÜÐÛìÝÞÙ ÜÞéÝÞáâØ ßÕàÕÔÐâçØÚÐ, ãÚÐ×ÐÝÝÞÙ Ò âÕåÝØçÕáÚØå 
åÐàÐÚâÕàØáâØÚÐå, ÒÞ ÒáÕå ÔØÐßÐ×ÞÝÐå àÐÑÞçØå çÐáâÞâ. ¸×ÜÕàÕÝØÕ 
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R) ÚÞíääØæØÕÝâÐ SAR ÒëßÞÛÝïÕâáï ßàØ ÜÐÚáØÜÐÛìÝÞÙ ÜÞéÝÞáâØ, ßÞíâÞÜã 

äÐÚâØçÕáÚÞÕ ×ÝÐçÕÝØÕ ãàÞÒÝï SAR ÔÛï àÐÑÞâÐîéÕÓÞ âÕÛÕäÞÝÐ ÜÞÖÕâ 
ÞÚÐ×Ðâìáï ×ÝÐçØâÕÛìÝÞ ÝØÖÕ. ºÞÝáâàãÚæØï âÕÛÕäÞÝÐ ßàÕÔãáÜÐâàØÒÐÕâ 
ÒÞ×ÜÞÖÝÞáâì àÐÑÞâë ßàØ ÝÕáÚÞÛìÚØå àÐ×ÛØçÝëå ãàÞÒÝïå ÜÞéÝÞáâØ, Ð íâÞ 
ßÞ×ÒÞÛïÕâ ØáßÞÛì×ÞÒÐâì ÜØÝØÜÐÛìÝãî ÜÞéÝÞáâì, ÔÞáâÐâÞçÝãî ÔÛï 
ãáâÐÝÞÒÛÕÝØï áÞÕÔØÝÕÝØï á áÕâìî. ²ÞÞÑéÕ ÓÞÒÞàï, çÕÜ ÑÛØÖÕ Ú ÐÝâÕÝÝÕ 
ÑÐ×ÞÒÞÙ áâÐÝæØØ ÝÐåÞÔØâáï âÕÛÕäÞÝ, âÕÜ ÜÕÝìèÕ ÜÞéÝÞáâì Ø×ÛãçÐÕÜÞÓÞ 
âÕÛÕäÞÝÞÜ áØÓÝÐÛÐ.

½ÐØÑÞÛìèÕÕ ×ÝÐçÕÝØÕ ÚÞíääØæØÕÝâÐ SAR ÔÛï âÕÛÕäÞÝÐ ÚÞÜÜãÝØÚÐâÞàÐ 
Nokia 9210i, ßÞÛãçÕÝÝÞÕ ßàØ ØáßëâÐÝØïå ÝÐ áÞÞâÒÕâáâÒØÕ áâÐÝÔÐàâã, 
áÞáâÐÒÛïÕâ 0,34 ²â/ÚÓ. ½ÕáÜÞâàï ÝÐ ÒÞ×ÜÞÖÝëÕ àÐ×ÛØçØï ãàÞÒÝÕÙ SAR ÔÛï 
àÐ×Ýëå ÜÞÔÕÛÕÙ âÕÛÕäÞÝÞÒ Ò àÐ×Ýëå ßÞÛÞÖÕÝØïå, ÒáÕ ÞÝØ áÞÞâÒÕâáâÒãîâ 
âàÕÑÞÒÐÝØïÜ áÞÞâÒÕâáâÒãîéØå ÜÕÖÔãÝÐàÞÔÝëå ÔØàÕÚâØÒ ÝÐ àÐÔØÞçÐáâÞâÝÞÕ 
ÞÑÛãçÕÝØÕ.

* ¿àÕÔÕÛìÝëÙ ãàÞÒÕÝì SAR ÔÛï ÜÞÑØÛìÝëå âÕÛÕäÞÝÞÒ ÞÑéÕÓÞ ÝÐ×ÝÐçÕÝØï 
áÞáâÐÒÛïÕâ 2,0 ²â/ÚÓ á ãáàÕÔÝÕÝØÕÜ ßÞ ÔÕáïâØ ÓàÐÜÜÐÜ âÚÐÝØ âÕÛÐ çÕÛÞÒÕÚÐ. 
ÍâÞâ áâÐÝÔÐàâ ßàÕÔãáÜÐâàØÒÐÕâ ×ÝÐçØâÕÛìÝëÙ ×ÐßÐá ßÞ ÑÕ×ÞßÐáÝÞáâØ, çâÞ 
áÛãÖØâ ÔÞßÞÛÝØâÕÛìÝÞÙ ÜÕàÞÙ ×ÐéØâë ÝÐáÕÛÕÝØï á ãçÕâÞÜ ÜÐÚáØÜÐÛìÝÞÓÞ 
àÐ×ÑàÞáÐ Ø×ÜÕàÕÝØÙ. ·ÝÐçÕÝØï SAR ×ÐÒØáïâ Þâ ÓÞáãÔÐàáâÒÕÝÝëå áâÐÝÔÐàâÞÒ Ø 
ÝÞàÜÐâØÒÞÒ Ø Þâ áÕâÕÒëå ÔØÐßÐ×ÞÝÞÒ. ´Ûï ÔàãÓØå àÕÓØÞÝÞÒ ØÝäÞàÜÐæØï SAR 
ßàØÒÞÔØâáï Ò àÐ×ÔÕÛÕ, áÞÔÕàÖÐéÕÜ ØÝäÞàÜÐæØî Þ ßàÞÔãÚæØØ, ßÞ ÐÔàÕáã 
www.nokia.com.


